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INTRODUCTION

The Challenge

Ensuring that patients have continuous access to tuberculosis (TB) treatment requires complex
projections and calculations by TB program staff. These projections are becoming more
challenging as new diagnostic tools rapidly increase the number of individuals diagnosed, and
thus the quantities of medicines needed. As treatment regimens change, national programs must
plan carefully for phasing in and out various medicines in order to manage the risk of stock outs.
Frequent quantification, along with management of stock on hand, are vital to ensuring that
appropriate types and quantities of medicines are available to meet the changing needs of
programs and that TB programs are alerted of potential problems with TB medicines in a timely
manner.

A Solution

To promote a systems-strengthening approach to TB medicines management, the USAID-funded
Systems for Improved Access to Pharmaceuticals and Services (SIAPS) Program developed
QuanTB—a downloadable, desktop tool that transforms complicated calculations into a user-
friendly dashboard displaying key quantification and supply planning information. By alerting
users to risks of stock outs, QuanTB operates as an early warning mechanism.

QuanTB allows you to forecast needs of tuberculosis medicines and treatment regimens for any
period of time. Quantification can be done by:

e The number of enrolled and expected cases per month or by percentage of use of each
medicine

e Either multidrug or single-drug regimens

For cases currently on treatment, QuanTB takes into account the month when treatment was
started and the duration of regimen. The system also takes into account the medicines currently
in stock (stock on hand), and the medicines on order (stock on order) during the quantification
period. This tool also allows you to project your future procurement and budget needs.

You may download the QuanTB software from http://www.msh.org/resources/quantb

We would appreciate your testing of this tool under different scenarios and providing feedback,
comments, and suggestions. Please send your comments to quantb@msh.org.



mailto:quantb@msh.org
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INSTALLING QuanTB

Installation on a PC

1. Visit the QuanTB website at http://www.msh.org/resources/quantb to request a copy of
QuanTB. You will receive an e-mail with a link to download the software. Use the link in
the e-mail to download and save the QuanTB software to your computer.

2. Double-click on the QuanTB.zip file to unzip it. You will get a folder called QuanTB
Download.

3. Inthe QuanTB Download folder, double-click on the QuanTBforPC.exe file to run it.
The Language Selection screen will appear:

rE] Language 5... @1

Please select your language

% English -

Figure 1

4. In this example, English was selected. Click OK to continue. The following screen
appears:
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P ack - Installahion of quanth

version 4.1.0.1

QuanTB

Tuberculosis Medicines Quantification Tool

"USAID SIAPS 77

7 Systems for Improved Access
¥ FROM THE AMERICAMN PEQOPLE to E"ha.rms...:ul::..s]s and Services

Copyright @ 2012 Management Sciences for Health, Inc. All rights reserved.
Developed by MSH

{Made with |zPack - http:/fizpack org/)

Figure 2

5. Click Next to continue then read the license agreement that appears. You must accept the
terms of the agreement to continue the installation, as shown in the screen below.




Installing QuanTB

E] IzPack - Installation of quantb E\IEIE

Please read the following license agreement carefully:

End User License Agreement for e-TB Manager |E|

eTB Manager@ SOFTWARE LICENSE

READ THE TERMS AND CONDITIONS OF THIS -TB Ma.nagerg SOFTWARE LICENSE
AGREEMENT (“EULA™) CAREFULLY BEFORE DOWNLOADING, INSTALLING, OR USING THE

e-TB M:mage-rg' SOFTWARE PROGRAM, THE SOURCE CODE, TOOLS, AND RELATED
DOCUMENTATION ("PRODUCT™). YOU MAY USE THE PRODUCT ONLY ON THE CONDITION
THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS EULA. IF YOU DO NOT
AGREE TO THE TERMS AND CONDITIONS OF THIS EULA, DO NOT DOWNLOAD, INSTALL,

OFR USE THE PRODUCT. BY ACCESSING AND USING ANY PART OF THIS PRODUCT, YOU
ACGREE TN BRE BOITNT BY THE TERAMS ME THIS EIT A i

@) I accept the terms of this license agreement.

() I do not accept the terms of this license agreement.

{Made with |zPack - http://izpack.org/)

Previous ]| Mext |[ Quit ]

Figure 3

6. Enter an installation path for the software, as shown on the screen below and then click
Next. We recommend accepting the default path that the program suggests.

IzPack - Installation of quantb =
i 9 ===

Select the installation path:

|:: \Wsersljfrye\QuanTB

{Made with IzPack - http://izpack org/}

Previous H Mext H Quit ]

Figure 4
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7. The program will confirm the installation directory it will create. Click OK to continue.

P -

Message @
C:I The target directory will be created:
ChUsershjfryelQuanTB
| oK | | Cancel |
Figure 5

8. Select the packs you want to install. We recommend installing all of them. The greyed
options are required, so you cannot unselect them. QuanTB comes with pre-populated
lists of medicines and regimens standardized by the Global Drug Facility (GDF) and the
World Health Organization (WHO) in the dictionary folder. QuanTB also has some
“fictitious” quantifications for training/exercise purposes in the documents folder. If you
have already installed QuanTB on your computer with customized lists of medicines and
regimens or saved quantifications, your information will be overwritten if a new version
is installed and the boxes are checked during the installation.

If you are reinstalling the software after customizing the medicines, regimens, or
quantifications, please read the Upgrading or Reinstalling QuanTB section of this manual
to learn how to protect your existing medicines and regimens lists. If this is the first time
you are installing QuanTB, we recommend keeping all of the boxes checked. Click Next
to continue.
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9.

Select the packs you want to install:
MNote: Grayed packs are reguired.

Dictionaries 37.438 KB
Documents 165,14 KB
Libraries 28.95 MB
QuanTB 1.62MB
Description

Dictionaries: regimens, medicines

Total space Reguired: 31MB
Available space: 119.34 GB

{Made with |zPack - http://izpack.crg/)

Previous l| Mext |[ Quit ]

Figure 6

If you already have QuanTB installed in the same location and the dictionary and

document boxes are checked, the system will warn you that you will overwrite files. An
example for one of the files is shown below. Select No if you want to keep previously

modified drug lists and/or treatment regimens. See the section on Upgrading or
Reinstalling QuanTB for more information.

File already exists - med_dictionary.xml|

Yes | [ Mo

()

@ The following file already exists. Should it be overwritten?C:h\UsershjfryelQuanTB\data\med_dictionary.xml

Figure 7

10. The software will display its installation progress, as shown on the screen below. Click

Next to continue.
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Pack installation progress:

[Finished]

Overall installation progress:

5/5

{Made with IzPack - hitp://izpack.org/)

Previous || Mext |[ Quit ]

Figure 8

11. Choose which shortcuts you want the program to create for you, then click Next:

-t ot s S = -

[=] Setup Shortcuts

Create shorteuts in the Start-Menu
Create additional shortcuts on the desktop:

Accessories

Administrative Tools

Dell

Maintenance

Management Science for Health
MWSnap

Startup

create shortcut for:
(@) current user

(@) all users

{Made with |zPack - hitp:/fizpack ong/)

Previous ][ Next H Quit ]

Figure 9

12. A screen confirming a successful installation will appear next.
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E}IzPack-InstalIation of quantb EI = @

Installation has completed successfully,

An uninstaller program has been created in:
C:\Wsers\ifrye\QuanTBWUninstaller

{Made with |zPack - http://izpack.crg/)

Daone

Figure 10

Depending on your version of Windows, you may get a Program Compatibility Assistant
message after the installation (shown below). You should click the “This program installed
correctly” option.

[=7] Program Compatibility Assistant @
This program might not have installed correctly

If this program didn't install correctly, try reinstalling using settings that
are compatible with this version of Windows,

Program: Unknown Program
Publisher: Unknown Publisher
Location: ChUsershjfryeiDocumentsh.. Ainstall_quantb (2).exe

® Reinstall using recommended settings

= This program installed correctly

Cancel

II&I What settings are applied?

Figure 11
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@ Note: As with any software, you should back up your data on a regular basis. If you used
the default installation options, the medicines and regimens lists are stored in
C:\Users\yourname\QuanTB\data. Your quantification files are stored in C:\Users\ yourname
\QuanTB\docs.

This user’s guide is available electronically through the Help menu option in the software.

Installation on a Macintosh

1. Visit the QuanTB website at http://www.msh.org/resources/quantb to request a copy of
QuanTB. You will receive an e-mail with a link to download the software. Use the link in
the e-mail to download and save the QuanTB software to your computer.

2. Toinstall QuanTB on a Macintosh, you must have the latest version of Java and the JDK
(Java Development Kit) installed on your Mac. Go to www.java.com to download
updates if necessary. Your computer will prompt you to install the software if it is
necessary.

3. Double-click on the QuanTB.zip file to unzip it. You will get a folder called QuanTB
Download.

4. Inthe QuanTB Download folder, double-click on the QuanTBforMacintosh.jar file to
run it.

5. If you downloaded the installation file from the Web, you may need to bypass the Mac
Gatekeeper software to run the install. Do this by holding down the Control key and

clicking the QuanTBforMacintosh.jar file. Then click Open on the menu that appears
and Open on the popup window to begin the installation.

6. The Language Selection screen will appear:

™ O Language Selection

Please select your language below

eng B

Figure 12

7. Select your desired language and click OK to continue. The following screen appears:

10


http://www.java.com/

Installing QuanTB

1zPack - Installation of QuanTB

version 4.1.0.1

QuanTB

Tuberculosis Medicines Quantification Tool

/=Y USAID SIAPS 7

w Systems for Improved Accen
; s FROM THE AMERICAN PEOPLE ] Pharma::uh.l.- and Services

Copyright & 2012 Mamnage

Made with IzPack - hitp./ fizpack.ong/)

Figure 13

8. Click Next to continue then read the license agreement that appears. You must accept the
terms of the agreement to continue the installation, as shown in the screen below.

Please read the following license agreement carefully:

End User License Agreement for QuanTB o

QuanTB” SOFTWARE LICENSE

READ THE TERMS AND CONDITIONS OF THIS lenTB'n SOFTWARE LICENSE
AGREEMENT ("EULA™) CAREFULLY BEFORE DOWNLOADING, INSTALLING, OR USING

THE QuarlTB'n SOFTWARE PROGRAM, THE SOURCE CODE, TOOLS, AND RELATED
DOCUMENTATION (“PRODUCT™). YOU MAY USE THE PRODUCT ONLY ON THE
CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS EULA. IF YOU
DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS EULA, DO NOT DOWNLOAD,
INSTALL, OR USE THE PRODUCT. BY ACCESSING AND USING ANY PART OF THIS

A4

() | accept the terms of this license agreement.
() 1 do not accept the terms of this license agreement.

{Made with IzPack - http://izpack.org/}

( Previous ) ( Mext ) ( Quit )

Figure 14

11
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9. Enter an installation path for the software, as shown on the screen below and then click
Next. We recommend accepting the Applications default path that the program suggests.

800 |zPack - Installation of quantb

Select the installation path:

"’_ Browse... \

[Applications guantb

{Made with |zPack - http://izpack.org/)

"r_ Previous \ ( MNext W 'r Quit \

Figure 15

10. The program will confirm the installation directory it will create. Click OK to continue.

8.0.0 Message

[f”_“x The target directory will be created:
-_— [Applications /quantb

'r_ Cancel “‘ f OK W'I

T S S
Figure 16

11. Select the packs you want to install. We recommend installing all of them. The greyed
options are required, so you cannot unselect them. QuanTB comes with pre-populated
lists of medicines and regimens standardized by the GDF and WHO (in the dictionary
folder) and some “fictitious” quantifications for training/exercise purposes (in the
documents folder. If you are reinstalling the software after customizing the medicines,
regimens, or quantifications, please read the Upgrading or Reinstalling QuanTB section
of this manual to learn how to protect your existing medicines and regimens lists.

12
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If you are reinstalling the software after customizing the medicines, regimens, or
quantifications, we recommend that you uncheck the documents and dictionary boxes to
preserve your existing files. If this is the first time you are installing QuanTB, we
recommend keeping the boxes checked. Click Next to continue.

8,00 IzPack - Installation of quantb

Select the packs you want to install:
Mote: Grayed packs are required.

L Dictionaries 30.28 KB|
Documents 237.52 KB
| Libraries 5.89 MB
QuanTB 778.86 KB
Description

Dictionaries: regimens, medicines

Total space Required: 7.03 MB
Available space: 3.26 CB

{Made with |zPack - http:/fizpack.org))

(" Previous \ ( Next ) { Quit \

Figure 17

If you already have QuanTB installed in the same location, the system will warn you that you
will overwrite files. Select No if you want to keep previously modified drug lists and/or
treatment regimens.

13



QuanTB User’s Guide

000 |zPack - Installation of quantb
2.0 Jamingl
The directory already exists! Are you sure you want to install here and possibly ovenwrite existing files?

{Made with |zPack - http:/ /izpack.org/)

[ Previous ] [ MNext ] [ Quit ]

Figure 18

12. The software will display its installation progress, as shown on the screen below. Click
Next to continue.

Pack installation progress:

—_——Finishedrerorornro—m—0 ——
Overall installation progress:

R e B

{Made with IzPack - http://izpack.org/)

"_ Previous \ H ( Quit )
. 2

Figure 19

13. A screen confirming a successful installation will appear next. Click Done to complete
the installation process.
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B P A 1 N 1153 1 [ 10 eI (111 S

Installation has completed successfully.

{Made with IzPack - http://izpack.org/)

|_Done |

. _______________________________________________________________a
Figure 20

14. To run the program, go to Applications and double click on the QuanTB folder.

[z Applications

800

FAVORITES
= All My Files iTunes Launchpad MacNewbie Mail
@ AirDrop
!/-\ Applicati...
[ Desktop vee
@ Bocuents Messages Mission Control OpenOffice
€ Downloads
= Movies A
JJ Music (5] % :
(& Pictures s u

SHARED Photo Booth Preview QuanTB QuickTime Player
i7erin

o

= julie-dell... 5 -
- sEEE By -@"ﬂ-
erin TR e
lerin2 B
— . Reminders Safari Stickies System Preferences
va-jfrye2

DEVICES - - =~
@ Remote... -~ 5 i "
I NON.. & ¥ &

Terminal TextEdit Time Machine Utilities
Figure 21

15. When the folder opens, double click on the QuanTB.command file to launch QuanTB.

15
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eoo ] QuanTB

(2l>] Bl=omm(#](=-][=] Q

FAVORITES
= All My Files
4P AirDrop
o Applicati... data docs lib
[ Desktop
[ Documents L
0 Downloads \-—;
H Movies L

77 Music quantification-1.0. Uninstaller

L.2.jar
Pictures

SHELL

QuanTB.command

SHARED

[E i7erin

(= julie-dell...
(S terin

(= lerin2

[E va-ifrye2
DEVICES

() Remote...
L)NON.. =

Figure 22

@ Note: As with any software, you should back up your data on a regular basis. If
you used the default installation options, the medicines and regimens lists are stored in
C:\Users\yourname\QuanTB\data. Your quantification files are stored in C:\Users\
yourname \QuanTB\docs.

This user’s guide is available electronically through the Help menu option in the software.

Upgrading or Reinstalling QuanTB

If you are upgrading or reinstalling QuanTB after modifying the medicines and/or regimens lists,
you need to take steps to ensure that you do not overwrite your data and lose your work. As a
precaution before reinstallation, go to the location where your QuanTB files are saved and copy
the DATA folder and save it in a different location. If you make a mistake during the
reinstallation and overwrite your medicines or regimens lists, you can replace the new data files
with your old files to restore your customized lists.

When upgrading or reinstalling QuanTB, you have three options during the installation:
e Use the same location as the old version and overwrite existing program files.
e Use the same location as the old version and do not overwrite existing program files.

e Use a different location for the installation and do not affect your original installation at
all.

16



Installing QuanTB

The program files of QuanTB are defined as the medicines and regimens lists, the quantification
examples (i.e., the “Fictitia” files), and the software itself.

Use the same location as the old version and overwrite existing program files

If you use all of the default options in the installation program, QuanTB will alert you that files
already exist and will ask if it should overwrite the old versions. If you accept, your previous
QuanTB medicines lists and treatment regimens files will be replaced with new versions. If you
have modified the medicines list or treatment regimens in the old version, your work will be lost
once the files are replaced with the new versions.

O Note: If you have created and saved quantification files with your own names,
these are not overwritten, even if you reinstall in the same location as the old version and
allow QuanTB to overwrite all existing files. QuanTB only overwrites the files that are
distributed as part of the standard installation, i.e., the quantification examples, the
medicines and regimens lists, and, of course, the software itself.

Use the same location as the old version and do not overwrite existing program files
When you are running the installation program, uncheck the dictionaries box (Figure 6) to
preserve your information. Your medicines list and regimens list will not be changed by
reinstalling the software.

If you leave the documents box checked, QuanTB will ask you whether you want to overwrite
the quantification examples (i.e., the “Fictitia” files) that were included in your original version
of the software. If you have not modified these examples, it is fine to overwrite them. Any
quantification files that you have created with your own names are not affected by the
reinstallation.

O Note: When upgrading from QuanTB version 1.0, you must update your existing
medicines and regimens lists if you do not overwrite them with the files provided with
the new software.

e For the medicines list, go to each medicine and select the dosage form from the
new dropdown list.

e For the regimens list, go to each regimen and click on the Composition link to
auto-generate the composition.

Use a different location for the installation

If you change the default installation path (shown in Figure 4) to a different location than you
used previously, you are creating a new copy of QuanTB on your computer. You can have
multiple copies of QuanTB on your computer in different locations, for example if you want to
do quantifications for different countries. In this case, you must leave the document and
dictionary boxes checked because the program requires the folders and files to run.

17
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® Note: QuanTB must find a data folder with files named med_dictionary.xml and
reg_dictionary.xml in it (e.g., C:\Users\yourname\QuanTB\data) to run with full
functionality. If that folder or files are missing, you can open and run quantifications and
change the numbers of cases in them, but you can’t access the regimens or medicines
through the File menu. You can delete medicines and regimens from quantifications, but
you can’t add or edit them.

Version Compatibility

If you create a treatment regimen with three or more phases in QuanTB version 2.0.0 (or later),
then try to open that regimen dictionary file (or a quantification using it) in a previous version of
QuanTB, it will NOT work properly because information will be lost. This is because earlier
versions of the software only recognize treatment regimens with two phases or fewer. For this
reason, we recommend that all current users upgrade to version 4.0 (or later), which recognizes
all treatment regimens and quantifications, regardless of which version was used to create them.

18



CUSTOMIZING QuanTB

Double-click the QuanTB icon or filename on your computer to start the software. Before you
start using QuanTB, you need to customize the tool for specific country settings, e.g., adding
new medicines or regimens to the system.

The opening screen summarizes the steps you need to take. You can click the option at the
bottom of the screen to display or hide this text.

[E=S Bl

USAID SIAPS &~

Systems for Improved A
o Fharmaceuticals a

FROM THE AMERICAN PEOPLE o i

m QuanTB - Tuberculasis Medicines Quantification Tool
File Medicines & Regimens Import & Export  Divide & Merge  Help

s EH© & = il = @& 7
QuanTB 4.1

Before using QuanTB, follow the steps below to adapt it for your location.

1. Go to the Medicines & Regimens menu and select Edit medicines.

# QuanTB is installed with all of the medicines from the Global Drug Facility (GDF) catalogue.
- If this medicines list is not compatible with your location, update it. Refer fo the QuanTB User's Guide for help.

2. Go to the Medicines & Regimens menu and select Edit treatment regimens.

= QuanTB contains treatment regimen examples for training purposes only.
= Refer to the QuanTB User's Guide for information on how to enter your treatment regimens.

3. After updating the Medicines and Treatment Regimens, you are ready to start using QuanTB.

= To creale a new guantification (forecasting), go to the File menu and select New.
- To open a saved quantification (forecasting), go to the File menu and select Open.

As you use QuanTB, save your work on a regular basis. QuanTB does not save data automatically.

Go to QuanTB User's Guide. ..

Click here to hide or display the quick help message

Copyright® 2012 Management Sciences for Health, Inc. All rights reserved. Developed by MSH.

Figure 23

Modifying the medicines list

1. Go to Medicines & Regimens menu and select the Edit medicines menu option.

19
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{11 QuanTB - Tuberculosis Medicines Quantification Tool (=N EER =)

File Medicines & Regimens Import& Export Divide & Merge Help

0 = — o .
:::tr::al::l:risreg\mens - “ (&) s @I U SAI D SIAP% /Z/
' 1 i o =N

dd from — B
Add from quantification FROM THE AMERICAN PEOPLE 1), bhiaes

Before using QuanTB, follow the steps below to adapt it for your location.

1. Go to the Medicines & Regimens menu and select Edit medicines.

= QuanTB is installed with all of the medicines from the Global Drug Facility (GDF) catalogue.
- If this medicines list is not compatible with your location, update it. Refer to the QuanTB User's Guide for help.

2. Go to the Medicines & Regimens menu and select Edit treatment regimens.

= QuanTB contains treatment regimen examples for training purpases only.
-a Refer to the QuanTB User's Guide for information on how to enter your freatment regimens.

3. After updating the Medicines and Treatment Regimens, you are ready to start using QuanTB.

-« To create a new quantification (forecasting). go to the File menu and select New_
- To open a saved quantification (forecasting). go fo the File menu and select Open.

As you use QuanTB, save your work on a regular basis. QuanTB does not save data automatically.

Go to QuanTB User's Guide..

Click here to nide or display the quick help message
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Figure 24

2. QuanTB is installed with all of the medicines from the Global Drug Facility (GDF)
catalogue. To add medicines on this list, click on the New button. In the New medicine
dialog box that appears, enter the international nonproprietary name (INN), abbreviated
name, strength, and select the dosage form and type from the dropdowns. If you select
“Other” you can enter information in the field below the dosage form. The type is “Adult
first line,” “second line injectable,” etc. and is selected from the dropdown window. Click
on the Save button to confirm your new medicine or click on Cancel to undo it.

Medicines |E|
MNew Edit Delete Type of medicine |— L
Abbreviated name International Monpro| New medicine @ Type of medicine L
AM(500) Amikacin X X Second-Line Injectable A
AM(50072) Amikacin temaonaliionpeptict il el Wi Second-Line Injectable H
AmMuCW250/125) Amaoxicillin + Clavular] D3-Second-Line Add-On
AMX/CIM500/125) Amoxicillin + Clavular| Abbreviated name ( ] D3-Second-Line Add-On
AmxCIv(875/125) Amoxicillin + Clavular] D3-Second-Line Add-On —
Bdq(100) Bedaguiline Strength [ ] D2-Second-Line Add-On
Cfz(100) Clofazimine Other Core Second-Line
Cfz(50) Clofazimine Dosage form [ot Applicable ~] Other Core Second-Line
Clr{250) Clarithromycin D3-Second-Line Add-On
Clr{500) Clarithromycin D3-Second-Line Add-On
Cm(1000) Capreomycin Type |- i ‘ Second-Line Injectable
Cm(500) Capreomycin Second-Line Injectable
Cm(750) Capreomycin Second-Line Injectable
Cs(250) Cycloserine Other Core Second-Line
DIm({50) Delamanid D2-Second-Line Add-On
E(100) Ethambutol 100mg Film coated tablets) Pediatric First-Line/D1-Second-Line Add =
Close

Figure 25

If you try to create a new medicine with (or edit an existing medicine to have) the exact
same name, abbreviated name, strength, and dosage form of an existing medicine,
QuanTB will not permit it. Any difference in any of these fields, including capitalization,
dots, or spaces will be understood by QuanTB as a different medicine and you will be
permitted to save the item. Be careful not to create duplicates.
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3. To change or delete medicines on the list, click on the medicine you want to modify and
the Edit and Delete buttons will be enabled. Click on the buttons and follow instructions
in the respective dialog boxes that appear. If you modify a medicine that has been used in
a regimen, you must delete it from the regimen and re-add it so that the updated
information appears in the regimen.

Modifying the treatment regimens list

1. Go to Medicines & Regimens menu and select the Edit Treatment regimens menu

option.
(.. QuanTB - Tuberculosis Medicines Quantification Tool (E=5 EcR (57|
File Medicines & Regimens Import & Export Divide & Merge Help
[ | Edit medicines [ e | Q
Edit treatment regimens F (X} U SAI D SIA[)S
Add from quantification L 7/ . FROM THE AMERICAN PEOPLE s T r lm' als s

Before using QuanTB, follow the steps below to adapt it for your location.

1. Go to the Medicines & Regimens menu and select Edit medicines.

= QuanTB is installed with all of the medicines from the Global Drug Facility (GDF) catalogue.
= If this medicines list is not compatible with your location, update it. Refer to the QuanTB User's Guide for help.

2. Go to the Medicines & Regimens menu and select Edit treatment regimens.

 QuanTB contains freatment regimen examples for training purposes only.
w Refer to the QuanTB User's Guide for information on how to enter your freatment regimens.

3. After updating the Medicines and Treatment Regimens, you are ready to start using QuanTB.

= To create a new quantification (forecasting). go to the File menu and select New.
= To open a saved quantification (forecasting), go to the File menu and select Open.

As you use QuanTB, save your work on a regular basis. QuanTB does not save data automatically.

Go to QuanTB User's Guide. ..

Click here to hide or display the quick help message

I Copyright ® 2012 Management Sciences for Health, Inc. All rights reserved. Developed by MSH.

Figure 26

2. The tool already contains treatment regimens for training purposes only. To create a
regimen, select Multidrug or Single Drug in the dropdown window, and then click on the
New button.

@ Note: When creating or selecting regimens, please remember that in QuanTB,
quantification can be done either by regimens, or by percent of use of each medicine. Thus,
two types of regimens can be created depending on how you want to quantify: multidrug
regimens for quantification by regimens, or single-drug regimens for quantification by
percent of use of each medicine. The steps below describe multidrug regimens first, then
single-drug regimens. The term “single-drug regimen” is used for convenience, to distinguish
it from multidrug regimens.
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- - T Ew et
ULt Fill s - T TN, —
Duplicate Edit Delete Type of regimen: |Multidrug v
Treatment Regimen Composition

Adult FL New Treatment (56-70Kg): 2{(RHZE)4(RH) 2RHZE(150/75/400/275)/4RH(150/75) ~

Adult FL Re-freatment (56-70kg): 28(RHZE)1(RHZE)S(RHE) 25(1000)RHZE(150/75/400/275)3&N-5/21Gx1.5 and Safety Box WFI(5)MRHZE(150/75/400/275)¥5RHE(150/75/275)

Longer MDR-TB Regimen 1: (weight 56-70kg) 8Cm({1000)Cs(250)Lix(250)Pio(250)5&N-5/21Gx1.5 and Safety Box WFI(5)Z(500)14Cs(250)Lx(250)Pto(250)S&N-5121Gx1.5 and ...
|| [Lenger MDR-TB Regimen 2: (weight 56-70kg) 8Km(1000/4)Eto(250)LA(250)PAS(Na)S&N-5/21Gx1.5 and Safety Box WFI(5)Z(500)14Eto(250)Lf(250)PAS(Na)S&N-6/21Gx1.5 a

Pediatric FL New Treatment (11-14kg). 2(RHZ)E/4(RH) 2E(100)RHZ(60/30/150)/4RH(B0/30)

Pediatric FL New Treatment (NEW Regimen):.{(12-15kg) 2(RHZ)E/4(RH) 2E(100)RHZ(75/50/150)/4RH(75/50) ™

Figure 27

NOTE: If you want to number your treatment regimens, you should use a leading 0 with the
numbers 1 through 9 (e.g., 01, 02, 03), so that they will appear in the correct order. If you
don’t use a leading 0 and you have more than nine regimens, the numbers 10 and higher will

appear in the wrong order.

3. Inthe New Treatment Regimen dialog box that appears, enter information in the Name
field. The Composition field will be automatically completed by the software, based on
the medicines you enter. You may modify it after the regimen is created, if you wish.
You may add up to 10 phases for each regimen and have a duration of weeks or months

for each phase.

In the Phase 1 window that appears when you create a new treatment regimen, click on

the Add Medicine button. In the list of medicines that appears, select the medicines you
want to add to the regimen by clicking the checkbox(es), and click on the Save button to
confirm or Cancel to undo it. Use the dropdown window to set the Duration by choosing

a number and weeks or months.

For each medicine in the phase, click in the appropriate column to enter the Units per

Day and Days per Week.

If you have more than one phase for this regimen, click the Add phase button. Repeat the
process described above by clicking on the Add Medicine button in the Phase 2 window.
Another option is to copy the previous phase by clicking on a phase, then clicking the Copy
previous button. When you click this button, the system copies information from the immediate
previous phase of the one that is selected and replaces all existing information in the selected
phase. For example, if there are 3 phases and the second is selected (i.e., opened), the system will
copy data from the first phase. This resource can be useful when the same medicines have been

used in more than one phase.
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@ Note: Because there is an average of 4.3 weeks per month, the quantities required for
a regimen defined in weeks will differ from a regimen defined in months. The difference
increases with the length of the regimen and can be surprising, if you are assuming that 4
weeks equals one month. Four weeks does not equal one month, because four weeks is 28
days and one month is 30 or 31 days.

Name [MDR-TB Regimen 1: weight 56-70 kg ] [ Multidrug ]
Composition f l
Add phase | Copyprevious | Delete phase
Phase 1
puraton | o Zl|months ~ | Addmedicine | Delete medicine
Units Days
Medicine per per
Day Week
Select medicines ﬂ
Type of medicine: E ~
Abbreviated name International Monproprietary Name (INN} Strength Dosage form Type of medicine |
C|am(500) Amikacin 500mg Powder for injection Second-Line Injectable -
[]|Am(500/2) Amikacin 500magi2ml Solution for injection Second-Line Injectable
| Amw/CIv(2501125) Amaogicillin + Clavulanic acid 250mg+125mg Film coated tablet(s) D3-Second-Line Add-On
D AmxCIv(500/125) Amaxicillin + Clavulanic acid 500mg+125mg Film coated tablet(s) D3-Second-Line Add-On
D Amx/CIVB7EM25) Amoxicillin + Potassium clavulanate 875mg+125mg Film coated tablet(s) D3-Second-Line Add-On
[|Bdgr100) Bedaguiline 100mg Film uncoated tablet(s) |D2-Second-Line Add-On
[\ Cf{100) Clofazimine 100mg Capsule(s) Other Core Second-Line
[J|crz(50) Clofazimine 50mg Capsule(s) Other Core Second-Line
O cir(250) Clarithromycin 250mg Film coated tablet(s) | Other
D Clr(500) Clarithromycin 500mg Film coated tablet(s) Other
[J/cm(1000) Capreomycin 1000mg Powder for injection Second-Line Injectable
[C]/em(500) Capreomycin 500 mg Powder for injection Second-Line Injectable
[J/em(750) Capreomycin 750mg Powder for injection Second-Line Injectable
LJics(250) Cycloserine 250mg Capsule(s) Other Core Second-Line
D DIm(50) Delamanid 50mg Film coated tablet(s) D2-Second-Line Add-On ?
[ sae || cancel
Figure 28

4. After adding medicines in the relevant number of phases and entering information on the
Units per Day, Duration (weeks or months), and Days per Week fields, click on the

Save button to confirm or Cancel to undo it. Only whole numbers can be entered for
these fields. The software will fill out the Composition field for you, based on the
information you enter, but you may modify it if you wish.

The first number in the Composition field displays the number of months of the first
phase of the regimen. Any time there is a change in the number of months for a medicine
(e.g., when changing to the continuation phase), the software will insert a “/” to divide
the description. The first number after the “/” displays the number of months for the next
phase. The abbreviated names of the medicines (with their strength in parentheses) follow
the numbers of months. When a medicine has a duration of weeks, the weeks are
converted to months in the Composition field.
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@ Note: In keeping with international standards, we require that all medicines in a phase
have the same duration.

Mew treatment regimen @
Name [MDR-RB Regimen 1 (weight 51-70 kg) ] Multidrug ]
Composition [BCs(250)Lix(500)Pto(250)14Cs(250)L(250)Pto(250)Z(400) ]

| Add phase | Copy previous | Delete phase |

Phase 1 | Phase 2

Duration | 14 :1 months  » | Add medicine | | Delete medicine |
Units Days
Medicine per per
Day Week
Cycloserine 250mg Capsule(s) 3 3]
Levofloxacin 250mg Film coated tablet({s) 2 3]
Protionamide 250mg Film coated tablet(s) 3 3]
Pyrazinamide 400mg Film uncoated tablet(s) 4 6 &

Save Cancel

Figure 29

5. To modify recorded treatment regimens, select one regimen you want to change and click
on the Edit button. In the Edit treatment regimen screen that appears (below), you can
replace, delete or add medicines to an existing regimen.
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Edit treatrnent regimen
Name [MDR-TB Regimen 1 (weight 51-70ka) ] [ Wuftidrug
Composition [8Cm(1000)Cs(250)Lfk(250)Pta(250)Z(500)14Cs(250)Lfx(250)Pto(250)Z(500) |
Add phase | Copyprevious | Delete phase
Phase 1 | Phase2|
Duration | 8 :] maonths  » Add medicine Delete medicine
Units Days
Medicine per per
Day Week
Capreomycin 1000mg Powder forinjection 1 i}
Cycloserine 250mg Capsule(s) = 5
Levofloxacin 250mg Film coated tablet(s) 3 (i}
Protionamide 250mg Film coated tablet(s) = 6
Pyrazinamide 500mg Film uncoated tablet(s) 4 6
Save Cancel
Figure 30

To add a new medicine, click on the Add medicine button. In the Selected Medicines
dialog box that appears, choose the medicine(s) and click on the Save button to confirm
or Cancel to undo it. If necessary, repeat the process for medicines you want to add in
other phases.

Edit treatment regimen &=
Name [Adult FL New Treatmant (56-70Kg): 2(RHZEN4(RH) ] Multidrug
Camecstion [2RHZE(150/75/400/275)/4RH(150/75) |
Add phase | Copyprevious | Delete phase
Phase 1 | Phase 2 |
| Duration | 2 2l |months v Add medicine Delete medicine
. : I
| Units = Days
Medicine } per } per
; Day ; Week
4-FDC RHZE (150/75/400/275) 150mg+75mg+400mg+275mg Film coated tablet(s) ‘4 ‘7
Select medicines |
Type of medicine E v
| Abbreviated name ' International Nonproprietary Name (INN) Strength | Dosage form | Type of medicine =
[J|Am(500) Amikacin 500mg Powder for injection Second-Line Injectable ~
[] Am(500/2) Amikacin 500mag/2mi Solution for injection Second-Line Injectable
D Amx/CIv(250125) Amoxicillin + Clavulanic acid 250mg+125mg Film coated tablet(s) D3-Second-Line Add-On
(]| AmwCIv(5001125) Amoxicillin + Clavulanic acid 500mg+125mg Film coated tablet{s) D3-Second-Line Add-On
D AmMHCIVB75M125) Amoxicillin + Potassium clavulanate 875mg+125mg Film coated tablet(s) D3-Second-Line Add-On
[] Bdg(100) Bedaquiline 100mg Film uncoated tablet(s) |D2-Second-Line Add-On
D Cfz(100) Clofazimine 100mg Capsule(s) Other Core Second-Line
E] Cfz(50) Clofazimine 50mg Capsule(s) Other Core Second-Line
[l cir250) Clarithromycin 250mg Film coated tablet(s) Other
: ClIr(500) Clarithromycin 500mg Film coated tablet(s) Other
]/ Cm(1000) Capreomycin 1000mg Powder for injection Second-Line Injectable
]/ cm(500) Capreomycin 500 mg Powder for injection Second-Line Injectable
D Cm(750) Capreomycin 750mg Powder for injection Second-Line Injectable
(| Csi250) Cycloserine 250mg Capsule(s) Other Core Second-Line
D DIm(50) Delamanid 50mg Film coated tablet(s) D2-Second-Line Add-On i
[ Save | [ Cancel
Figure 31
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7. To delete a medicine, click on it and then click on the Delete Medicine button. In the
confirmation dialog box that appears, click on the Yes button to confirm or No to undo it.
If necessary, repeat the process for other medicines you want to delete in all phases.

Edit treatment regimen 3
Mame MDR-TB Regimen 1 (weight 51-70kg) Multidrug |
Composition 8Cm(1000)Cs(250)Lf(250)Pto(250)Z(500)/14Cs(250)L(250)Pto(250)Z(500)

Add phase | Copyprevious | Delete phase
Phase 1| FPhase 2
Duration | & Zlmonths » | Add medicine | | Delete medicine |
Units Days
Delet per per
See @ Day Week

Capreomycin 1000ma Powder for injection @ Confirm delete? 1 i
Cycloserine 250mg Capsule(s) 3 3]
Levofloxacin 250mg Film coated tablet(s) | ¥es | | Mo 3 i}
Protionamide 250mg Film coated tablet(s) 2 i}
Pyrazinamide 500mg Film uncoated tablet(s) 4 3]

Save Cancel

Figure 32

8. After all modifications are made, click on the word Composition to update the
description automatically. Then click the Save button to confirm or on the Cancel button
to undo them. Be careful not to create duplicate regimens. QuanTB follows the rules
below:

e If you try to create a new treatment regimen with the exact same name, medicines,
units per day, duration, and days per week of an existing regimen, QuanTB will
not permit it.

e If you create a new treatment regimen with the same name but other different
information (medicines, units per day, duration, and days per week), QuanTB
displays a warning message, but will allow the creation if you click the yes
button.

e If you create a new treatment regimen with a different name but the exact same
other information (medicines, units per day, duration, and days per week),
QuanTB displays a warning message, but will allow the creation if you click the
yes button.
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e If you edit a treatment regimen to have exactly the same name, medicines, units
per day, duration, and days per week of another existing regimen, QuanTB
displays a warning and will not save the information.

e If you edit a treatment regimen, keeping the name, but changing information for
the medicines, units per day, duration, and days per week to match an existing
regimen, QuanTB will display a warning message, but will allow the regimen
creation if you click the yes button.

e If you edit a treatment regimen, changing the name, but keeping information for
the medicines, units per day, duration, and days per week to match an existing
regimen, QuanTB will display a warning message, but will allow the regimen
creation if you click the yes button.

9. To delete recorded treatment regimens, select one regimen you want to remove and then
click on the Delete button. In the confirmation dialog box that appears, click on the Yes
button to confirm or No to undo it. If necessary, repeat the process for other regimens you
want to delete.

Treatment regimen - - - — 18 c Al o ®
New || Duplicate || Edit || Delste Type of regimen: [Wultidrug v
Treatment Regimen Composition
Adult FL Mew Treatment (56-70Kg): 2(RHZE)i4(RH) 2RHZE(150/75/400/275)4RH(150/75) 4
Adult FL Re-treatment (56-70kg). 2S(RHZEV1(RHZEVS(RHE) 25(1000)RHZE(150/75/400/275)S&N-5/21Gx1.5 and Safety Box WFI(5)1RHZE(150/75/400/275)5RHE(150175/275)
Longer MDR-TB Regimen 1: (weight 56-70kg) 8Cm(1000)C3(250)Lf(250)Pto(250)S&N-5/21Gx1.5 and Safety Box WFI(5)Z(500)14Cs(250)Lf(250)Pto(250)S&N-5/21Gx1 5 and
Longer MDR-TB Regimen 2: (weight 56-70kg) BKm(1000/4)Eto{250)Lix(250)PAS(Na)S&N-5(21Gx1.5 and Safety Box WFI(5)Z(500)(14E10(250)L (250 )PAS(Na)SEN-5/21Gx15 a
Pediatric FL New Treatment (11-14kg): 2(RHZ)E/4(RH) 2E(100)RHZ(60/30/150)/4RH(50/30)
Pediatric FL New Treatment (NEW Regimen):(12-15kg) 2(RHZ)E/4(RH) 2E(100)RHZ(75/50/150)/4RH(75/50) 3
Phase 1| Phase 2
] e =
Duration | & Z/ months w
@ Confirm delete?
Units Days
b Day Week
Capreomycin 1000mg Powder for injection 1 &
Cycloserine 250mg Capsule(s) 3 [
Levofloxacin 250mg Film coated tablet(s) 4 6
Protionamide 250mg Film coated tablet(s) 3 3
Pyrazinamide 500mg Film uncoated tablet(s) 4 6
Syringe & needle (auto-disabling) 21G Syringe & needle 2 [
‘Water for injection 5ml Water 1 G
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Treatment regimen

[ New ”Duphca{e” Edit H Delete

Type of regimen: [Multidrug ~

Treatment Regimen
2(RH)ZE/4(RH) - (weight 40-54kg)

‘Composition
2RH(150/75)Z(400)E(400)/4RH(150/75)

2(RHZE)4(RH) - (weight 40-54kg)

2RHZE(150175/400/275)i4RH(150/75)

MDR-TB Regimen 1 (weight 51-70kg)

8Cm(1000)Cs(250)Lix(250)P1o(250)Z(500)/14Cs (250)Lfx(250)Pto(250)Z(500)
MDR-TE Regimen 2 (weight 51-70kg) 3Km( 125)LM(250)PAS(NA)Z(500)14E10(126)L1(250)PAS(Na)Z(500)
Delete

'r\" Confirm delete?

tablet(s)

Phase 1 Phase 2 Phase 3 Phase 7 Phase 8 Phase 9
Medicine Units/day - Units/day - Units/day - - Unitsfday - Units/day - Units/day -
Daysiweek - D = D = Daysiweek - Daysiweek - Daysiweek-
Duration Duration Duration Duration Duration Duration Duration Duration Duration
E(400) Ethambutol
400mg Film coated 2-7-2months = -

Phase 10
Units/day -
Daysiweek -
Duration

i

<

RH(150/75) 2-FDC RH 3-7-2months | 2 -7 -4 months
I

[+]
T2l

Close

Figure 33

10. When creating new multidrug or single-drug regimens, you may copy an
existing regimen and edit it. The regimen you want to duplicate must be selected. The
click the Duplicate button to copy it. The regimen will appear in the list of regimens with
“- Copy” after the name. Click on it and modify it as described above.

Treatment regimen -wwww

M. .. T Shasams . ==

New Duplicate Edit Delete

Type of regimen: l

Treatment Regimen
Adult FL New Treatment (56-70Kg): 2(RHZE)/4(RH)

Composition
2RHZE(150/75/400/275)4RH(150/75)

>]

Adult FL New Treatment (56-70Ka): 2(RHZE)4(RH) - Copy

2RHZE(150/75/400/275)4RH(150/75)

Adult FL Re-treatment (56-70kg). 28(RHZE)1(RHZENS(RHE)

25(1000)RHZE(150/75/400/275)S&N-5/21Gx1.5 and Safety Box WFI(5)1RHZE(150/75/400/27 5)'5RHE(150/75/275)

Longer MDR-TB Regimen 1: (weight 56-70kg)

8CM(1000)Cs(250)L(250)Pto(250)SaN-5/21Gx1.5 and Safety Box WFI(5)Z(500)14Cs(250)L#(250)Pto(250)S8N-5/21Gx1.5 and

Longer MDR-TB Regimen 2: (weight 56-70kg)

8Km(1000/4)Eto(250)Lf(250)PAS(Na)S&N-5/21Gx1.5 and Safety Box WFI(5)Z(500)/14Et0(250)Lix(250)PAS(MNa)S&N-5/21Gx1.5 a...

Pediatric FL New Treatment (11-14kg): 2(RHZ)E/4(RH)

2E(100)RHZ(60/20/150)4RH(60/30)

<

Close

Figure 34

11. If your quantification is based on the percentage of use of each single TB medicine, you

must create single-medicine regimens. At the Treatment Regimen screen, select Single
Drug in the dropdown window, and then click New.
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g WWw . ET e . AR MEANS . ==

New Duplicate Edit Delete Type of regimen:
Treatment Regimen Compaosition
Amikacin 8 months 8AM(500/2) 7
Capreomycin 8 months 8Cm(1000)
Cycloserine 22 months 22Cs(250)
Etr 22 months 22Eto(250)
Kanamycin 8 months B8Km(1000)
Levofloxacin 22 months 221 &x(250) F|

Figure 35

12. Enter the Name of the treatment regimen and then click on Set Medicine. Select a
medicine by clicking on it on the Select medicines screen that appears. Click Save to
confirm your choice or Cancel to discard it.

" New treatment regimen I
fices
Name [Ethambutol ]
Composition f 1
0 [
Add phase | Delete phase T
Phase 1

Duration | 0 2/ [months w Set Medicine

<|

Units Days
Medicine per per
Day Week
| Type of medicine: [— vl
Abbreviated name International Nonproprietary Mame (INN) Strength Dosage form Type of medicine
Cm(750) Capreomycin 750mg Powder for injection Second-Line Injectable (4]
Cs(250) Cycloserine 250mg Capsule(s) Other Core Second-Line
DIm(50) Delamanid 50mg Film coated tablet(s) D2-Second-Line Add-On
E(100) Ethambutol 100mg Dispersible tablet(s) Other
E(100) Ethambutol 100mg Film coated tablet(s) Pediatric First-Line/D1-Second-Line Add...
E(200) Ethambutol 200mg Film coated tablet(s) Pediatric First-Line/D1-Second-Line Add...
E(400) Ethambutol 400mg Film coated tablet(s) Adult First-Line/D1-Second-Line Add-On
E(600) Ethambutol 600mg Film coated tablet(s) Adult First-Line/D1-Second-Line Add-On
E(800) Ethambutol 800mg Film coated tablet(s) Adult First-Line/D1-Second-Line Add-On
EH(400/150) 2-FDC EH (400/150) 400mg+150mg Film coated tablet(s) Adult First-Line/D1-Second-Line Add-On
Eto(125) Ethionamide 125mg Film coated tablet(s) Other Core Second-Line
Eto(250) Ethionamide 250mg Film coated tablet(s) Other Core Second-Line
H(100) Isoniazid 100mg D fablet(s) Pediatric First-Line/D1-Second-Line Add.
H(300) |soniazid 300mg Film uncoated tablet{s) Adult First-Line/D1-Second-Line Add-On
ImifCls(500/500) Imipenem + Cilastatin 500mg+500mg Powder for injection D3-Second-Line Add-On |
Save ‘ [ Cancel
Figure 36

13. On the New treatment regimen screen, enter the Duration (in weeks or months), Units
per Day and Days per Week for that medicine. The system will not allow you to enter
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more than one medicine. Click on the Save button to confirm or on the Cancel button to

undo it.
New treatment regi -1 -‘ R
EW reatment regimen e - @
Name [Ethambutol ] Sinale drug ]
Compaosition
| Add phase | Delete phasze
FPhase 1
| Duration | 22 2! [months
|
| Units Days |
Medicine per per
Day Week
Ethambutol 100mg Film coated tablet(s) ) B
Save Cancel

Figure 37

@ Note: The list of medicines is stored in the med_dictionary.xml file and the list of
regimens is stored in the reg_dictionary.xml file, both located in the QuanTB data folder. You
can only have one version of each of these files in this folder. If you need to have two different
lists of medicines (or regimens), e.g., because you are working with two countries, you must
install two copies of QuanTB on your computer in different folders.

Changing languages

After QuanTB is installed, you can switch from one system language to another by clicking the
flag icons at the top of the screen. If you hover the mouse over the flag, you can see the name of
the language that it represents. When changing the language of the tool, QuanTB checks all open
quantifications before making the change. If any quantification is not executed, the system will
prompt you to save it. If any quantification was executed with an error or warning message (e.g.,
for cases or percentage with zero or missing information on parameters tab) QuanTB will display
these messages again before changing the language.
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{2 QuanTE - Tuberculosis Medicines Quantification Tool
File Medicines & Regimens Import & Export Divide & Merge Help

e fHes= R =N |
(k)
Q

~

Figure 38
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If you created your medicines and regimens in one language, when you change to another
language, everything that is free text (i.e., not in a dropdown window) will remain in the
language in which it was created. You will have to go to each field and re-enter the free text
information in the new language. Please note that the medicines list and the sample regimens that
come with QuanTB when installed are in English. You may translate these to another language if

necessary.
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STARTING A NEW QUANTIFICATION

As you use QuanTB, please save your work on a regular basis.
QuanTB does not save data automatically.

It is important to understand that the calculations in QuanTB quantifications assume 100%
adherence, that is, that all patients receive all doses of all medicines and no one is lost to follow-
up. If you know the attrition rate for each medicine, you can enter it for the enrolled and
expected cases. These results will appear in the dashboard. If you simply adjust the quantity to
order, that will not appear on the dashboard.

Opening a new quantification

Go to the File menu and select the menu option for New or click on the New icon in the left
upper corner. Enter the variables/parameters in the fields and check/select the regimens you want
to forecast in the list. All fields must be filled out. See the explanation below about the fields in
the New quantification dialog box.

—l__

Mame of Country/Region/Facility:

Mew quantification

Mame ofthe person performing the quantification:

Oct 22, 2016

Lead time: 12

Inventory date:

(months)
0

[0 2! (months)

End date of quantification:

Minimum months of stock:

Maximum months of stock: | o 2 (months)

Adult FL Mew Treatment (56-70Kg): 2(...

Regimen type: [Multidrug v
Enrolled Cases: By number w Expected Cases. |Bynumber w
Select regimens

Treatment Regimen Compaosition

2RHLE(150/75/400/27 5)4RH(150/75)

Adult FL Re-treatment (56-70ka): 25(...

23(1000)RHZE(150/75/400/275)3&N-5/21CGx1.5 and Safety B...

Longer MDR-TB Regimen 1: (weight ...

8Cm(1000)Cs(250)Lfx(250)Pto(250)58M-5/21Gx1.5 and Safe...

Longer MDR-TB Regimen 2: (weight .

BKm(1000/4)Eto(250)LM(250)PAS(Na)S&N-5/21Gx1.5 and Sa...

Pediatric FL Mew Treatment (11-14kg...

2E(100)RHZ(60/20/1 50 4RH(60/30)

Pediatric FL Mew Treatment (NEW Re._.

2E(100)RHZ(75/50/1504RH(75/50)

Shorter MDR1 (30-50kg). 5KmCizE H...

5Km(1000/4)Cfz{100)E(400)H{300)Mi(400)Pto(250)S&N-5/2._

Shorter MDR2 (30-50kg) 5SCmCRZEH...

S5Cm(1000)Ciz(100)E(400)H(200)Mix(400)Pto(250)S&MN-5/21...

3 O o )

| [ Cancel |

Figure 39
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Name of Country/Region/Facility: Defines the context to which the quantification refers

Name of the person performing the quantification: Defines the individual who is entering
data and generating the results of the quantification

Inventory date: The current day as set on your computer is automatically entered. You may
move the Inventory date back to the past if needed (e.g. if your medicines stock information is
dated), but you should not move it forward. The inventory date should be the date you counted
the stock information you are entering, so an inventory date in the future will not have any
inventory information. The quantification begins the day after the Inventory date.

Lead time: Enter the number of months normally necessary for your orders to arrive. The figure
entered should include all of the time that starts with planning for quantification and ends when
the medicines are available on the shelf. It is not simply the suppliers’ lead time. QuanTB will
allow you to enter O for the lead time, but we strongly recommend that you don’t because it is
not realistic.

End date of quantification: Defines last day of the period for which the quantification is made.
This is a future period and the start date must be later than the inventory date plus the lead time.
When you enter a date, the quantification period will automatically appear next to the end date.

Minimum months of stock and Maximum months of stock: Enter the minimum and
maximum number of months of stock that you want to keep on hand. These figures affect the
stock calculations. They are used to set the range of months on the dashboard and to determine
the estimated months of stock. The first day of the month(s) QuanTB calculates that you reach
the minimum level of stock triggers the need to order. If you have not set a minimum, a stock out
triggers an order. If you want to keep buffer stock, you must include it in your minimum. The
minimum and maximum can’t be the same, unless both are zero. If you set the minimum stock to
0, QuanTB will calculate the quantities needed as if minimum stock were set to one.

Regimen type: Select multidrug or single-drug in the dropdown window.

Enrolled cases: Use the dropdown window to select whether you want to enter the number of
enrolled cases by number or by percentage.

Expected cases: Use the dropdown window to select whether you want to enter the number of
expected cases by number or by percentage.

Select Regimens: All treatment regimens previously defined in the system are displayed here.
Check the boxes for regimens you want to forecast.

@ Note: QuanTB doesn’t allow performing quantification for multidrug regimens and single
drugs in the same quantification. You can either select full multidrug regimens for quantification
by number of regimens and percentage of cases on each regimen (as many regimens as you
need), or select single-drug regimens for quantification by percentage of each medicine use
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against total number of cases (as many drugs as you need). In the New quantification dialog box
you may check only multidrug regimens or single-drug regimens in the Select Regimens boxes
and create two separate forecasts to accommodate these needs. You cannot simultaneously use
both methods.

For the greatest precision, use multidrug regimens and numbers of cases. The next most precise
option is to use multidrug regimens and percentages. Using single-drug regimens will produce
less precise quantifications.

After filling in the fields, click on the Save button to confirm your choices. The system creates a
New quantification tab with the Parameters tab inside. Clicking on the Cancel button will
close the dialog box and all entered information will be lost.

If you expect to have attrition in your program, you can use the Adjust medicines quantity for
attrition button to reduce the quantity initially calculated for each medicine related to enrolled
and expected cases. This adjustment is reflected in the quantity needed (summary, medicine, and
medicine detailed reports), and also appears in the dashboard. In the example below, the
medicine quantities have been adjusted for a 10% reduction in enrolled cases and a 5% reduction
in expected cases.

o )

Adjust medicines quantities @
Adjust for Adjust for
Medicine enrolled cases | expected cases
(%) (%)
Capreomicin 1000 mg Powderfial a0 a5
Cycloserine 250 mg Tablet or Capsule |90 a5
Ethionamide 250 mg Tablet a0 a5
Kanamycin 1000 mg Powderial a0 a5
Levofloxacin 250mag Tablet a0 a5
P-aminosalicylate sodium salt 4000m... |90 a5
Prothionamide 250mg Tablet a0 a5
Pyrazinamide 500 mag Tablet a0 a5

Figure 40

If you make changes in the Parameters, save them, and then click on the Execute
Quantification button to make them effective and see updated results. QuanTB does not save
data automatically.
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Case information

Previously entered variables are displayed in the New quantification tab and can be changed as
needed. The Enrolled Cases, Expected Cases and Stock of Medicines tabs are also displayed to
be completed as described below. You can click on the regimens of the quantification to see
more details about them. You can’t make changes to the regimens here.

Enrolled Cases
Total Number of Enrolled Cases per Month:

If you selected to forecast by actual cases enrolled per each regimen, the system will display all
of the months for the selected regimens depending on their duration, starting with the months in
which cases were enrolled that could still be on treatment at the inventory date. If, for example,
the duration of a selected regimen to treat MDR-TB is 22 months and the inventory date is April
1, 2013, the system will display months starting with July 2011, because some cases enrolled in
that month could still be on treatment, and thus must be accounted for in the quantification
process.

The date used in calculations is one day after the inventory date, after counting back the number
of months in the regimen. For example:
e Inventory date for the quantification: 15 October 2014
e Length of treatment regimen: 6 months
e The first date for the enrolled cases is 16 April 2014. This is six months before the
inventory date, plus one day.

For quantification calculations (consumption), entered cases are considered as started on
treatment in the first day of each month, unless the inventory date is not the first of a month.

For each month, you should enter the number of cases enrolled in this month.

You may copy and paste data from another source (e.g., Excel spreadsheet, Word table, QuanTB
quantification, etc.) into the enrolled or expected cases. To copy and paste, please follow these
rules:

e The sequence of the regimens in the source information must be same as for QuanTB
data. The system cannot verify that the information you are entering matches, so please
be careful that the sequence matches.

e The number of columns of the source information cannot be more than the number of
months of the longest regimen in your QuanTB quantification.

e The number of rows in the source information can be less than QuanTB, but cannot be
more.

e If the source information has fewer rows than QuanTB, the data will be pasted from the
top to the bottom (so the last rows in QuanTB will be blank).
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e Only whole numbers from the source information can be pasted to QuanTB, or an error
message is displayed. Zero is considered a whole number. Text is not permitted either, so
be careful that you don’t copy the names of your regimens from the source information.

e Anempty cell in Excel is considered a “non-whole number” and will trigger an error
message.

e You may copy selectively, e.g., only one cell (one month of specific regimen) of enrolled
and/or expected cases by double-clicking the number, hitting Ctrl C and pasting it to
another cell using Ctrl V.

e Asin Excel, if you copy a number, you may paste that number into multiple months in
QuanTB by highlighting the range of months, then hitting Ctrl V.

When regimens have different durations, the system considers the number of columns of the
longest for the pasting process (also for validation and generation of the error message related to
the number of columns displayed). If you leave the months not used for the shorter regimens
blank, the system displays an error message. You must fill the months not used in the shorter
regimens with some valid data (e.g., 0) to allow pasting, even if this information won’t be used
later.

In the example below, only the blue cells in Excel should be copied. No cells are blank, because
0 has been entered as the value for the cells with no enrolled cases in the MDR-TB 1 regimen.

MDR-TB 1 10 10 10 10 10 10 10 10 0 0
MDR-TB 2 3 ] ] ] ] ] ] ] ] ] ] ]

@ Note: If monthly enrollment data are not available, you can use the number of cases
enrolled per quarter, entering the data in the middle month of a quarter. Quantification in this
case will be less precise.

To perform “what if” scenarios, you can use the Enable box to mark which regimens should be
included in the quantification. Unticking the Enable box means that the regimen won’t be
included when you execute the quantification, although all of the information about regimen
remains and can be included in the quantification by simply ticking the Enable box and
executing the quantification again. If you enable/disable stock or regimens, you must execute the
forecasting to get the updated results.
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Parameters | Summary | Medicines Report | Cases Report | Medicines Detailed Report | Order and Schedule | Graphs
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Mame of Country/Region/Facility:

[Fictitia
Mar 31, 2016 [ 6 2! (monihs)  Dec31.2017 20 months, 30 days Mame of the persen performing the quantification
Minimum manths of stack: Maximum months of stock: [NTP

Inventory date: Lead time: End date of quantification: Quantification period;

s = wrel
[ (months) 18 2! (months) ] ] } :
Adjust medicines quantity for attrition Selecttreatment regimens

Expected increase in cases enrollment from May 2016
Comment: )

Enrolled cases | Expected cases | Stock of medicines
Mumber of enrolled cases per month | Change to| By percentage Copy selected Paste number(s) |
Enable Treatment Regimen Jun-2014 Jul-2014 Aug-2014  Sep-2014 Oct-2014 Mov-2014  Dec-2014  Jan-2015 Feb-2015 Mar-2015

M Longer MDR-TB Regimen 1: (weight 56-70kg) 8Cm(1000)Cs(250)Lfx(... 3 3 4 3 3 3

|z| Longer MDR-TB Regimen 2: (weight 56-70kg) 8Km(1000/4)Eto{250)Lf 9 10 13 11 11 10 12 12 13 13

Execute quantification

[<I I >

Copyright® 2012 Management Sciences for Health, Inc. All rights reserved. Developed by MSH.

Figure 41

Percentage of Enrolled Cases per Treatment Regimen:

If you selected to forecast by percentage of use of each regimen, the system will display all
selected regimens. Enter the percentage of enrolled cases that are using each regimen. For multi-
medicine regimens the total percentage must be 100%. (For single medicines the calculations are
different, so the cumulative percentage could be any number.) Also enter the Total Number of
Enrolled Cases per Month for each month.

O Note: Using the percentage method is not recommended for quantification in a setting
with a small number of enrolled cases. However, if you do so, the system will keep cases in the
Case Report tab as decimals and round up only for the total medicines quantities needed by
month.
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Fictitia_2016 %]

Parameters | Summar Medicines Report  Cases Report  Medicines Detailed Report  Order and Schedule  Graphs

Inventory date: Lead time: End date of quantification:  Quantification period Name of Country/Region/Facility:
Fictitia
Mar 31, 2016 [ 6 ! (monihs)  Dec31.2017 20 months, 30 days Mame of the person performing the quantification
Minimum manths of stack: Maximum months of stock: NTP
= ]
63 (months) 18 2! (months)
Adjust medicines quantity for attrition Selecttreatment regimens
Expected increase in cases enrollment from May 2016
Comment: P
5] Execute quantification
Enrolled cases | Expected cases | Stock of medicines
Percentage of enrolled cases per reatment regimen. Change to: | By number Total number of enrolled cases per menth Copy selected || Paste number(s)
Enable Percentage of enrolled Month Mumber of enrolled cases
Treatment regimen o Jun-2014 12[A]
®  |Longer MDR-TB Regimen 1: (waight 56-70kg) 8CM(1000)Cs(25 2249 Jul-2014 13
®  |Longer MDR-TB Regimen 2: (weight 56-70kg) 8Km(1000/4)Eto(... 7751 Aug-2014 7
Sep-2014 14
Oct-2014 14
Nowv-2014 13
Dec-2014 15
Jan-2015 15
Feb-2015 17
Mar-2015 17
Total 100.00 % e v
1 Copyright® 2012 Management Sciences for Health, Inc. All rights reserved. Developed by MSH.
Figure 42

Expected Cases

Estimated number of expected cases per month: The system will display all of the months for
the selected regimens, starting with the inventory date and ending with the end of the
quantification period. Enter the numbers of cases you expect to enroll by month of the
quantification period

On the Expected Cases tab, the first month displayed can be the same as the last month of the
enrolled cases, if the inventory date is not the first of the month. The inventory date divides the
enrolled cases and expected cases, so if the inventory date is 15 October 2014, the enrolled cases
stop on 14 October 2014 and the expected cases start on 15 October 2014. Until the reference
date, cases are enrolled and after the reference date, they are expected. The expected period starts
the day after the reference date. Be careful not to double-count cases in that month if the
inventory date is in the middle of the month.

You may copy and paste data from another source (e.g., Excel spreadsheet, Word table, QuanTB
quantification, etc.) into the enrolled or expected cases. To copy and paste, please follow these
rules:

e The sequence of the regimens in the source information must be same as for QuanTB
data. The system cannot verify that the information you are entering matches, so please
be careful that the sequence matches.

e The number of columns of the source information cannot be more than the number of
months of the longest regimen in your QuanTB quantification.
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e The number of rows in the source information can be less than QuanTB, but cannot be
more.

e |f the source information has fewer rows than QuanTB, the data will be pasted from the
top to the bottom (so the last rows in QuanTB will be blank).

e Only whole numbers from the source information can be pasted to QuanTB, or an error
message is displayed. Zero is considered a whole number. Text is not permitted either, so
be careful that you don’t copy the names of your regimens from the source information.

e Anempty cell in Excel is considered a “non-whole number” and will trigger an error
message.

e You may copy selectively, e.g., only one cell (one month of specific regimen) of enrolled
and/or expected cases by double-clicking the number, hitting Ctrl C and pasting it to
another cell using Ctrl V.

e Asin Excel, if you copy a number, you may paste that number into multiple months in
QuanTB by highlighting the range of months, then hitting Ctrl V.

When regimens have different durations, the system considers the number of columns of the
longest for the pasting process (also for validation and generation of the error message related to
the number of columns displayed). If you leave the months not used for the shorter regimens
blank, the system displays an error message. You must fill the months not used in the shorter
regimens with some valid data (e.g., 0) to allow pasting, even if this information won’t be used
later.

In the example below, only the blue cells in Excel should be copied. No cells are blank, because
0 has been entered as the value for the cells with no enrolled cases in the MDR-TB 1 regimen.

MDR-TE 1 10 10 10 10 10 10 10 10 0 0
MDR-TE 2 3 3 3 3 3 3 3 3 3 3 3 3

@ Note: For quantification calculations (expected consumption), entered cases are
considered as started on treatment in the first day of each month. The only exception is the
month of the inventory date (first month displayed), where cases are considered as started
on treatment on the inventory date.
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Minimum manths of stack:

Inventory date: End date of quantification:

Dec 31,2017

Maximum months of stock:

"«

Mar 31, 2016

[ 6 2 (months) months)

Expected increase in cases enrollment from May 2016
Comment:

Quantification period.

Mame of Country/Region/Facility:

[Fictitia
20 months, 30 days

MName of the person performing the quantification

[NTP

Adjust medicines quantity for attrition ‘ ‘

Selecttreatment regimens

5] Execute quantification
Enrolled cases | Expected cases | Stock of medicines

Estimated number of expected cases per month | Change fo: By percentage Copy selected ‘ ‘ Paste number(s) |
Enable Treatment Regimen Apr-2016 May-2016 Jun-2016 Jul-2018 Aug-2016 Sep-2016 Oct-2016 MNov-2018 Dec-2018 Jan-2017 F

@ Longer MDR-TE Regimen 1: (weight 56-70kg) 8Cm(1000}Cs(250)Lf(... 9 44 44 49 49 49 49 49 49 49
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[<] I D>

1 Copyright® 2012 Management Sciences for Health, Inc. All rights reserved. Developed by MSH.

Figure 43

Percentage of Expected Cases per Treatment Regimen: Displays all selected regimens.
Enter the percentage of expected cases that will be using each regimen. For multi-
medicine regimens the total percentage must be 100%. (For single medicines calculations
are different, so the cumulative percentage could be any number.)

@ Note: Using the percentage method is not recommended for quantification in a setting
with a small number of enrolled cases. However, if you do so, the system will keep cases in the
Case Report tab as decimals and round up only for the total medicines quantities needed by
month.

Estimated Number of Expected Cases per Month: Enter the total numbers of cases you
expect to enroll by month of the quantification period, for all regimens.

To perform “what if” scenarios, you can use the Enable box to mark which regimens should be
included in the quantification. Unticking the Enable box means that the regimen won’t be
included when you execute the quantification, although all of the information about regimen
remains and can be included in the quantification by simply ticking the Enable box and
executing the quantification again.
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Copyright @ 2012 Management Sciences for Health, Inc. All rights reserved. Developed by MSH.

Figure 44

Changing from quantification by number to quantification by percentage and vice versa

You can change how you enter information about your enrolled and expected cases by clicking
the By number or By percentage button, which is above the treatment regimens on the
Parameters tab, as shown below. The option on the button will be the method you are not
currently using.

Using this option allows you to try different scenarios, but certain things must be understood:

e You can only switch between the percentage and number methods for multidrug
regimens (not for single-drug regimens).

e You must execute the quantification to see the results of your change.

e The results of each type of quantification will be different.

e If you change the quantification method, saving, executing, or exporting the forecasting
will replace your last numbers or percentages with the newly calculated values, so you
should save the quantifications under different names if you want to be able to see them
all.

e |If you want to keep your changes after changing from one method to the other, you must
save the quantification.
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Figure 45

Stock information
Stock of Medicines

This tab displays all the medicines that compose the selected treatment regimens. Clicking on the
quantity causes the batch details for that medicine to appear. For the stock on hand, the first-to-

expire batches are listed first. For the stock on order, the earliest expected receiving date is listed
first.

QuanTB has a feature to create a template that you can fill in and then import into the software,
saving time. You must have a quantification file open. Then go to the Import & Export menu,
click on Import from Excel, then click on Get template for stock data.
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Figure 46

A window asking you to give your template a name will appear as shown below. Name the file
and decide where you want to save it.

EEESTESTS . )
I

Save in: [].dm:s v] [4}]
E ANl dataxisx

@ Stock Template xlsx
(] Without med details xlsx

File name: | Stock Data Template

File Types: [Excel file (xlsx) v]

Save ” Cancel ]

Figure 47
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When the file is created, you will be asked whether you want to open it. After clicking Yes, go to
Excel to see the file.

Export to Excel eS|

{ JB | Success! Do you want to open file?

Figure 48

A sample template is shown below.

Expiration date Expected Expiration date
Medicines Stock on hand | of the stock on | Stock on order .p. of the stock on
receiving date
hand order
Figure 49

Fill in your inventory information, including the Medicines, Stock on hand, Expiration date of
the stock on hand, Stock on order, Expecting receiving date, and Expiration date of the
stock on order (if known). Save your file.

To import this template into QuanTB, click on the Import & Export menu, then Import from
Excel, then Import stock data.

@ Note: Do not copy and paste information into this template because you will change
important formulas and formatting.

Or, if you don’t want to use the template and your stock on hand data is in your own spreadsheet,
you can import that into QuanTB. The data containing the medicine names, quantities, and
expiration dates must be properly formatted and in an .xlIsx file. To format the file, use the
Define Name feature in the Formulas tab in Excel:
e Select the range of cells with the medicine names, and then define the name for it as “M”
(without the quotes). This range must only contain medicine names or numbers and blank
cells.
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Select the range of cells with the stock on hand quantities, and then define the name for it
as “Q” (without the quotes). This range must only contain whole numbers.

Select the range of cells with the stock on hand expiration dates, and then define the
name for it as “D” (without the quotes). This range must only contain dates.

Select the range of cells with the stock on order quantities, and then define the name for it
as “QO” (without the quotes). This range must only contain whole numbers.

Select the range of cells with the stock on order expected receiving dates, and then define
the name for it as “DE” (without the quotes). This range must only contain whole
numbers.

Select the range of cells with the stock on order expiration dates, and then define the
name for it as “DO” (without the quotes). This range must only contain dates.

Tip: If you need to make changes in your named ranges, use the Name Manager option in the
Excel Formulas tab.

After defining the names (or after making any changes to the spreadsheet), save the file. Certain
rules must be followed in the formatting:

You can list a medicine name more than once (e.g., for multiple batches), but all of the
repeated batches for that medicine must be in contiguous rows.

All ranges must start from the same row and the first row must not be blank.

Each range must only have one column.

Do not select the entire column to define the name and do not include the column heading
in the range.

If you have a medicine expiration date, you must have a quantity for it and vice versa.
Only the first sheet of data in the spreadsheet is imported.

Merged rows or columns will not be imported.

O Note: If you import your stock on hand data from Excel, it will overwrite the stock on
hand data that you have in the quantification to which you import it. If the quantity figure for an
item is blank in the import file, the quantification’s original data is preserved. If the quantity
figure is 0, the quantity for that item in the quantification will become 0.

To import your file into QuanTB, click on the Import & Export menu, then Import from
Excel, then Import stock data.
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Figure 50

After selecting your file, the following screen appears so that you can match the medicines in
QuanTB with the medicines in your spreadsheet. Click the dropdown arrow to show the list of
medicines from your spreadsheet and select the one that matches each QuanTB medicine. When

you click Save, the medicines, quantities, and expiration dates will be imported from the .xlsx
spreadsheet file.

orton et

CuanTB medicine Medicine to import

Capreomycin 1000mg Powder for injection rI w |
Kanamycin 1000mg/4ml Solution for injection
Cycloserine 250mg Capsule(s) Levofloxacin 250 mg tab
Ethionamide 125mg Film coated tablet(s) Ethambutol 400 mg tab
Levofloxacin 250mg Film coated tablet(s) Pyrazinamide 400 mg tab
P-aminosalicylate sodium salt 4000mg Powder/Sachet 2FDC RH 150+150 tab
F'rntin.namide 250mg Film coated tablet{s) ICapreomycin 1000 mginj
Pyrazinamide 500mg Film uncoated tablet(s) Cydlosefine 250 mg cap

Save | I Cancel

Figure 51

You can also enter your stock on hand data manually. Click on the cell value of Stock on Hand
for one medicine. Then, in the Batches Details box click on the Add button. In the dialog box
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that appears, enter the expiration date of the batch and the quantity of units available in stock (on
the inventory date). Click on the Save button to confirm or Cancel to undo it. If needed, repeat
the process for all existing batches of the same product and for all other medicines available on
stock.

@ Note: You may copy and paste numbers into the Stock on Hand Batches Details Quantity
field from another source (e.g., Excel file, Word table, QuanTB quantification, etc.) by copying a
number using Ctrl C and pasting it with Ctrl V.

.
{+] QuanTE - Tuberculosis Medicines Quantification Tool [=lEr| =

File Medicines & Regimens |Import & Export Divide & Merge Help
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" |
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on order
_ Apr 29, 2017 76,545

Cm(1000) Capreomycin 1000mg Powder for injection E
™ Nov 29, 2019 64,000

Km(1000/4) Kanamycin 1000mg/4ml Solution for injection
Cs(250) Cycloserine 250mg Capsule(s) 321,059
Eto(250) Ethionamide 250mg Film coated tablet(s) 750,000
Lfx(250) Levofloxacin 250mg Film coated tablet(s) 1,019,000

250,000

PAS(Na) P-aminosalicylate sodium salt 4000mg Powder/Sac.. 419,656
Pto(250) Protionamide 250mg Film coated tablet(s) 576,059
S&N-5/21Gx1.5 and Safety Box Syringe & needle (auto-disabli.. 400,000
'WFI(5) Water for injection 5ml 200,000
(500) P: ide A00ma_Film uncoated fablet(s 0724
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Figure 52

Click on the cell value of Stock on Order for one medicine. Then, in the Batches Details box
click on the Add button. In the dialog box that appears, enter the expected receiving date,
expiration date (if known, otherwise leave blank), and the quantity of units to be received. If you
make a mistake with the expiration date, click the Clear date link to delete it and re-enter it. Click
on the Save button to confirm or Cancel to undo your batch details. If needed, repeat the process
for all products expected to arrive.

@ Note: You may copy and paste numbers into the Stock on Order Batches Details
Quantity field from another source (e.g., Excel file, Word table, QuanTB quantification, etc.) by
copying a number using Ctrl C and pasting it with Ctrl V.
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Figure 53

Changing recorded information regarding stock on hand and stock on order:
To edit, double click on the specific information you want to change or click on the batch, then

click the Edit button. In the dialog box that appears change required data and click on the Save
button to confirm or Cancel to undo it.

Edit stock on order -‘--—u

Expected receiving date Sep 29, 2016

Expiration date Jun 29, 2018
Clear date
Quantity 72000 ]

Batch number andfor comments

[ 1

Save Cancel

Figure 54

To delete, click on the specific information and the Delete button will be enabled. Click on the

Delete button and in the confirmation dialog box that appears click on the Yes button to confirm
or No to undo it.

For your reference, the system uses the following date-related rules:

49



QuanTB User’s Guide

e The expiration date of stock on hand can be the same as or after the inventory date, but
cannot be earlier.

e The expected receiving date of the stock on order can be the same as or after the
inventory date, but cannot be earlier.

e The expiration date of the stock on order can be the same as or after the expected
receiving date, but cannot be earlier.

Selecting other treatment regimens:

To select other treatment regimens to be included in the quantification, click on the Select
Treatment Regimens button and in the Select Regimens dialog box that appears check or
uncheck the regimens displayed. Click on the OK button to confirm or Cancel to undo it. If you
have changed the selection of regimens done initially (in the New quantification dialog box),
you will need to repeat processes described above for entering data on Enrolled Cases, Expected
Cases, and Stock of Medicines (stock on hand and stock on order).

@ Note: If you execute the quantification, then edit any regimen information (e.g., dosages,
duration or medicines) that is included in this quantification, you must remove and re-insert the
regimen from the quantification for the regimen changes to register in the quantification. Do this
at the parameters tab by unchecking the box at the "Select regimen” dialog box and clicking the
OK button, then insert the regimen again by checking the box and clicking the OK button. When
you do this, the cases related to that regimen will disappear and you will have to re-enter them
before executing the quantification. You can save time by copying and pasting the case
information.

g QuanTB - Tuberculosis Medicines Quantification Toal ‘ = | E 22 ‘
File Medicines & Regimens Import & Export Divide & Merge Help
N oEn o Fr — pr
OCEhes - = @ ‘"‘% ~ )wﬁ./
&) (= JUSAID S5IAPS ~
L ’) W FROM THE AMERICAN PEOPLE 1, ervices
Fictitia_2016 %
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Elo(250) Ethonamids 250mg Fim coated ral 2% Cancel |
Lfx(250) Levofloxacin 250mg Film coated tablEls T
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Pto(250) Protionamide 250mg Film coated tablet(s) 576,059
S&N-5/21Gx1.5 and Safety Box Syringe & needle (auto-disabli 400,000
'WFI(5) Water for injection 5ml 200,000
Pvrazinamide 500ma_Fil R30 724
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Figure 55
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Once all parameters have been entered, SAVE them, then click on the Execute Quantification
button or click on the Arrow icon in the left upper corner.
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Figure 56

@ Note: If you re-execute the quantification after some time has passed (e.g., because you
have updated case information) but you have not updated your inventory information, stock may
have expired since you entered the inventory information. QuanTB will compare stock
expiration dates to the inventory date and will prevent you from re-executing the quantification
until you have adjusted expiration dates, expected receiving dates, and/or quantities, to ensure an
accurate forecast.

If you need additional information on quantifying for multiple years, ancillary medicines, or
patient kits, please see Annexes 1, 2, or 3, respectively.
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QUANTIFICATION RESULTS

After you execute the quantification, the following tabs with quantification results will appear:

Fictitia_2016 [¥

‘ Parameters | Summary | Medicines Report | Cases Report | Medicines Detailed Report | Order and Schedule | Graphs

Figure 57

Parameters tab

The Parameters tab includes the information you defined when you began the quantification.

Summary tab

The Summary tab includes a list of all of the medicines in your quantification. For each product,
it lists the following information:

On the inventory date
Stock on hand: Quantity of units of medicines available on the inventory date, according to the
stock on hand entered in the Parameters tab.

Estim. Months of Stock (excl. on order): This is the estimated number of months of stock on
hand as of the inventory date until the day before a stock-out. It doesn’t include stock on order.
The estimated months of stock on hand equals the stock on hand divided by the monthly
consumption. The consumption is based on regimens used and number of cases each month and
assumes 100% adherence. The figure appears in red if it is below/at the minimum or above/at the
maximum months of stock assigned by you in the parameters. This alerts you to an issue needing
attention, e.g., a pending stock-out or stock at risk of expiry due to overstock. If stock on hand at
the inventory date is zero, the estimated months of stock will be zero because stock is not
counted as available until it has actually arrived. If there is a stock-out, then an order is received,
then there is another stock-out during the period being considered, only the first stock-out date is
used.

Accelerated order period (with date range)

The Stock on order, Quantity dispensed, and Quantity likely to expire during the accelerated
order period are displayed. The Stock on order and quantity likely to expire figures may be blank
if they don’t occur during accelerated order period. The accelerated order period dates are
determined when the system calculates the expected needs, combined with the lead time, stock
on hand, and minimum stock level. They are meant to cover consumption during the lead time
period. If the accelerated order period ends in the middle of a month, the entire quantity to order
for that month is included as an accelerated order.
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Reqular order period (with date range)

The Stock on hand after accelerated order period, Stock on order, Quantity likely to expire,
Estimated consumption (enrolled cases), and Estimated consumption (expected cases) are
shown for the regular order period. The regular order period begins the day after the accelerated
order period ends and ends on the last day of the quantification period.

Quantity to order (entire date range)
The quantities to order during the Accelerated order period and Regular order period are
shown, along with the Total quantity.

Parameters | Summary | Medicines Report | Cases Report  Medicines Detailed Report | Order and Schedule = Graphs

Fictitia NTP Expected increase in cases enrollment from May 2016

On the inventary date Accelerated order period Regular order period Quantity to arder
Mar 31, 2016 £pri1, 2016, Sep 30, 2016 Qct01, 2016..Dec 31, 2017 Apr 01, 2016.. Dec 31, 2017
(183 days) (457 days) (640 days)
Medicine miﬁ:‘hrg o Quantity Stock on Estimated Estimated
Stock on Stock on Quantity hand after Stock on Quantity likely  consumption consumption  Accelerated Regular
stock likely to Total
hand arder dispensed ! accelerated arder to expire {enrolled {expected order petiod  order period
(excluding Bxpire
order period cases) cases)
on ordery

[>]

Capreomycin
1000mg Powder 140,545 18 - 22164 - 118,381 - - 104 149,003 - 81688 81,686
for injection

Kanamycin
1000ma/4ml
Solution for
injection

36,827 6 72,000 31,656 - 777 - - 338 170,457 48,248 103,616 151,864

Cycloserine

321,059 12 - 89,271 - 231,788 250,000 - 34,119 746,763 - 682 464 682 464
250mg Capsule(s)

Ethionamide

250mg Film 750,000 16 = 173,985 - 576,015 = - 117,120 855,957 = 839,322 839,322
coated tablet(s)

<]

Figure 58

Medicines report tab

The Medicine reports tab displays the following information for each medicine for each month of
the quantification period: Stock on hand, Quantity needed, Quantity likely to expire, Stock
on order, Estimated consumption (enrolled cases), Estimated consumption (expected cases),
and Estimated consumption (total cases). The Quantity likely to expire will appear in red. If
you hover over a cell, you will see the medicine and row name.
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Figure 59

Cases report tab

The Cases report tab displays the number of Enrolled Cases, Expected Cases, and Total cases
by treatment regimen and by medicine (on a separate tab) for each month of the quantification
period. The number of cases displayed is the maximum number of cases of any day in the entire
month.

Treatment regimen Apr-2016  May-2016  Jun-2016  Jul-2016 Aug-2016  Sep-2016 Oct-2016 Now-2016 Dec-2016 Jan-2017 Feb-2017 Mar-2017  Apr-2017  MWay-201

Enrolled

e 7500 7000 68.00 GE.00 52.00 B0.00 58.00 55.00 53.00 50.00 48.00 45.00 43.00 4

MDR-TB Regimen 1 {weight
51-70kg)y

E:Z:::Bd 5.00 12.00 22.00 37.00 B0.00 a7.00 117.00 147.00 177.00 207.00 237.00 267.00 297.00 3z
Total 80.00 22.00 90.00 102.00 122.00 147.00 175.00 202.00 230,00 267.00 285.00 312.00 340.00 26!
Figure 60
Treatment reglmen‘ Medicine
Medicine Apr-2016  May-2016  Jun-2016  Jul-2016 Aug-2016  Sep-2016 Oct-2016  Now-2016 Dec-2016 Jan-2017 Feb-2017 War-2017 Apr-2017  May-=z
A

Enralied 37.00 32.00 27.00 21.00 16.00 11.00 500
Cases

Capreomycin 1000mg

Powder for injection
Expected
Ere 5.00 12.00 2200 37.00 B0.00 er.o0 117.00 147.00 172.00 189500 215.00 230,00 237.00
Total 42.00 44.00 49.00 68.00 76.00 98.00 122.00 147.00 172.00 195.00 215.00 230.00 237.00

Figure 61

@ Note: The Treatment regimen tab on the Case reports tab is unavailable when the
quantification is only for single-drug regimens.

Medicines detailed report tab

The Medicines detailed report tab allows you to select a medicine from the dropdown and see
detailed information about that product’s stock during the quantification period. The screen
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shows Stock on hand, Estimated consumption (enrolled cases), Estimated consumption
(expected cases), Estimated consumption (total), Stock on order, Quantity likely to expire,
and the Minimum quantity to prevent treatment interruption. The Quantity likely to expire
will appear in red. The Minimum quantity to prevent treatment interruption will appear in
red in the months when an accelerated order is needed.

pryprp——
—— i s gy

5

Figure 62

Order and schedule tab

The Order and schedule tab has three sub-tabs: Quantity and Costs, Additional Costs, and
Schedule.

Quantity and Costs

The Quantity and Costs tab shows detailed information on the quantities needed for each
medicine, separated in tables for Consolidated regular orders, Consolidated accelerated
orders, and Consolidated total orders (the sum of regular and accelerated). The accelerated
procurement is meant to ensure that you have enough stock before you receive your regular
order. The tables are labeled “Consolidated” because there may be multiple accelerated and
regular orders. The Regular order and Accelerated order tables display the:

e Medicines

e Quantity needed (in units)
Adjustment (% of quantity needed): This is customizable by the user. It is “100” by
default, meaning no adjustment is needed. By entering other numbers and based on
statistics or experience, the order may be adjusted for mortality or loss for follow-up
rates, or other trends in the program. If you enter “0” it means that the medicine is not
required at all. As an example, if you want to reduce the quantity by 5%, enter 95% to
reflect that you want to order 95% of the suggested quantity.

e Pack size: This is customizable by the user. Enter the desired or known pack size here;
the final quantities of units will be rounded up to a full pack size.

e Pack price or unit price: This is customizable by the user and is helpful for estimating
budget needs. When using the unit price instead of pack price, enter “1” in Pack Size.

e Adjusted quantity to order (in units)

e Adjusted quantity to order rounded up to pack size

e Cost of the order
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@ Note: You may copy and paste numbers into the Adjustment (% of quantity needed),
Pack size, and Pack price or unit price fields from another source (e.g., Excel file, Word table,
QuanTB quantification, etc.) by copying a number using Ctrl C, double-clicking into the target
field, then pasting by hitting Ctrl V. You may also copy the pack sizes and prices of the regular
order to the accelerated order and vice versa.

The Regular order and Accelerated order adjustments can be entered separately, since they
may differ.

O Note: You must SAVE the quantification after entering or changing data in the
Adjustment Pack Size and Pack Price columns BEFORE executing the quantification. If you do
not save the data you enter, this information will be lost.

The Total order table displays the sum of the Regular order and Accelerated order tables:
Medicines

Quantity needed (in units)

Adjusted quantity to order (in units)

Cost of the order (The cost column is not displayed until you enter a pack price for each
quantity needed.)

The Total cost of medicines is shown at the bottom of the Quantity tab.

@ Note: If you have not entered a pack price or unit price for a medicine, QuanTB cannot
calculate a cost for it and therefore the Total cost of medicines figure will not include the cost of
that medicine.
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Additional Costs

The Additional Costs tab displays the total cost of medicines for regular and accelerated orders,
along with line items for additional costs specific to each TB program procurement, such as
Freight, Insurance , Pre-shipment inspection (PSI), Procurement agent, Customs clearance,
etc. These additional costs can be entered as percentage of order value or as flat fees. You can
enter your own types of costs and can add or delete the ones listed in the program. Any text you
enter will not change if you change the language of the program.. All additional costs are added
to get the Cost of Regular Order and Cost of Accelerated Order.

Parametess | Bum=ary | Medones Raport | Cases Repar | edones Delated Fiopon | Groer ana Schacule | Giaghs
Cuantty an Coata | Asamcnai & Tomal Covty | Sehacue
Consolidated regular arder{s)
Costof madicines 2555 438,16 USDS)
Bam Pescentige Vaue (USDS) Wead

1500
030

Total cost of requiar orers 1,182, 643,85 (USD3)

Cont ol medicings 145.935.00 (USOS)

000
040

Copy oM QA prop
Total cost.of nccekrabed orders 198,020.57 (I150%]

Grand total cost of all orders 3.380.677.58 (USD/3)

Figure 64

Schedule

The Schedule tab displays the accelerated and regular order quantities for the quantification.
QuanTB will propose a monthly schedule based on the needs and the maximum and minimum

58



Quantification Results

levels of stock you have entered. You can select a monthly, all at once, annually, bi-annually, or
quarterly order schedule.

The frequency of the orders will determine how many accelerated and regular orders are needed.
The accelerated orders appear first. Each order includes the following information: order date,
delivery date, medicines, adjusted quantity to order (in units), adjusted quantity to order rounded
up to pack size, and costs of medicines, additional costs, and the total for the order.

There are certain rules for the schedules:

e Choosing the “Monthly” delivery order means that an order will be recommended to
prevent the stock of any medicine falling below the minimum months of stock and will
be for a quantity sufficient to reach the minimum as of the first day of the order month.
Please note that the minimum months of stock DOES NOT include stock that may expire.

e Choosing the “All at Once” delivery order means that the date of the order will be
calculated based on the day that at least one of the medicines in the forecasting reaches
the minimum stock level in the defined period.

e Accelerated orders will appear first on the schedule of deliveries.

e The additional costs you have entered for your forecasting will be applied to each
delivery.

e The total number of packs in all orders may vary from the forecasted quantity because of
rounding to whole packs for each order.

e The schedule is calculated to ensure that the minimum stock level for each medicine is
available on the first day of the month (even if the forecasting period doesn’t start on the
first day of the month).

e The quantities in the schedule of deliveries are only meant to meet the needs of the
forecasting period. If you want or need to buy more in order to remain above your
minimum stock level, you can extend the forecasting period, do a new forecasting, or
update the current forecasting with new data every three months.

e The order date is calculated as the delivery date minus the lead time.

e When calculating needs and schedules, orders are assumed to be available on the first day
of the month in which they are expected, therefore their delivery date is assumed to be
one day earlier. For example, if an order is expected to be received in April 2017,
QuanTB assumes that the stock in that order will be available on 1 April 2017 and that
the stock was delivered on 31 March 2017.
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The Graphs tab has two sub-tabs: Stock Status and Dashboard. You should not rely on these
graphs to make decisions—they are simply to depict the highlights of a quantification.

Stock Status
On this tab, you can select a medicine to see the stock movement information graphically, by each

type of delivery schedule. You can also exclude planned deliveries from the graph. The line graph
shows the following information about the medicine: Consumption, Quantity likely to expire,
Stock on order, Planned delivery, Maximum stock, Minimum stock, and Stock on hand.

If you have a planned shipment, you should make the delivery date for it one day earlier than the
scheduled date so that the Stock on order and Planned delivery bars in the graph will appear
correctly. If you don’t adjust the date like this, you will see both a grey bar and a yellow bar on the
graph in the same month.

Stock Status | Dashboard
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Figure 66
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@ Note: The Stock Status graph only provides an overview of the stock situation. For a
more accurate view of the stock, you should always consult the Medicines Detailed Report.

To copy, save, or print the graph, right click anywhere in it and use the Copy, Save As, or Print
options. The name of the medicine will not be included so please make a note of it.

Dashboard

The dashboard displays each medicine’s status graphically on a timeline that begins with the
inventory date and ends with the quantification period end date. The green color represents stock
on hand. The yellow color is displayed for stock on order. The red color indicates a stock-out. The
pink background on the chart is for the time in between the minimum and maximum months of
stock that you have set. The gray color indicates that there was no stock and no planned
consumption of the item during that period. The vertical orange bars mark the beginning and end
of the quantification period. Information is displayed according to these rules:

e |f stock on hand is zero, the system displays a red bar for the entire period (inventory date
until the end of the quantification period).

e When stock is on order, the estimated receiving date for the stock is displayed when you
hover over the yellow bar. Where the bar is displayed does NOT represent when the stock
is expected to arrive. The yellow bar for stock on order represents the number of months
added to your stock on hand based on the quantity to be received. It is displayed at the
end of the green stock on hand bar to show this.

e Stock is not considered as available until it is actually received, so the color on the
dashboard will still show as red even after the date when the stock is expected to be
received.

e After a stock-out occurs, the system displays a red bar from the respective month until the
end of quantification period. The system displays stock on order that will arrive later as a
yellow bar inside the red bar. However, the system doesn’t display a green bar after a red
bar even if consumption occurred with enough quantity in stock on order to cover all
patients in the future.

e Regardless of the date when stock on order will be received, the system displays a yellow
bar for the entire month of receiving in case no consumption is planned to use that
specific quantity. If the stock on order arrives when there is enough stock on hand to
cover all patients in certain months, the system display the yellow bar only in months
when the cases start consuming the stock on order (this is the reason a message with the
month and year the stock on order will arrive is necessary).

e If you hover the mouse over the colored bars, the program will show the estimated
consumption figure, estimated enrolled, expected, and total cases for that time period.

e If stock is likely to expire in a period, an exclamation point (') will be centered in the
range. Where it appears does NOT represent precisely when the stock is likely to expire.

When reviewing the dashboard, a good guideline to use is that you want to see green bars for each
medicine extending into the pink area on the chart. If the green bar for a medicine doesn’t reach the
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pink area, you are in danger of a stock-out and should take action. If the green bar extends past the
pink area, you may be overstocked and at risk of medicines expiring on the shelf.

@ Note: The Dashboard only provides an overview of the stock situation. For a more
accurate view of the stock, you should always consult the Medicines Detailed Report.

[Estmated consempsion is 413,088
Est miter of snrobed cases is 263
[abmated umbet of eipected canes i 281
- [E3bmated fumtt of #teohbd 30 cHed 4143 18 504

Figure 67

To copy, save, or print the dashboard, right click anywhere in it and use the Copy, Save As, or
Print options.

Saving quantifications

A quantification can be saved at any time, even before execution. Each quantification must be
saved manually.

QuanTB does not save data automatically.

Go to the File menu and select the Save menu option or click on the Disk icon in the left upper
corner. In the confirmation dialog box that appears, click on the Yes button to confirm or No to
undo it.
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Figure 68

In the dialog box that appears when you click “Yes,” the system directs you to the “Docs” folder
of the system but you can select another location on your computer. Fill out the File Name field
and click on the Save button to confirm or Cancel to undo it. The QuanTB folder button is a
shortcut to return you to the docs folder location in the QuanTB program with one click, if you

have navigated away from it.

Save in: [,. docs

v] (4] [B]EE]

|| Fictitia 1-1-2013 fast rev.qtb
| | Fictitia 1-1-2013 rev.gtb

|| Fictitia 1-1-2013 slow rev.qto
|| JEF.qgtb

QuanTB folder

File name: |new forecasting|

File Types: |Forecasting data file

Figure 69
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For saving a previously saved quantification, go to the File menu and select the Save as ... menu
option. The same dialog boxes will appear to save the quantification in a selected folder. Fill out
the File Name field and click on the Save button to confirm or Cancel to undo it.

Opening saved guantifications

Saved files can be retrieved later for further work. Go to File menu and select the Open menu
option or click on the Folder icon in the left upper corner. In the dialog box that appears, select
the location where the file was saved and then double click in the specific file to open or click on
the Open button. Click on the Cancel button to undo it. The QuanTB folder button is a shortcut
to return you to the docs folder location in the QuanTB program with one click, if you have
navigated away from it. The <Last 5 docs> option in the File menu is also a convenient way to
find recent files.

-

[4] Open forecasting document 2
Lookin: ) docs v||£{}||”._||._||
|_| Fictitia 1-1-2013 fast rev.qgtb QuanTB folder
|| Fictitia 1-1-2013 rev.qth
|| Fictitia 1-1-2013 slow rev.qtb
|| JEF.qtb
File name: |
File Types: |[Forecasting data file w |

Open || Cancel |

Figure 70

@ Note: If you erase cases and/or percentages data in an executed quantification, then
execute the quantification again, QuanTB will generate an error message. The system will
disable the existing tabs (except Parameters tab) until adequate data is entered to execute the
quantification properly.
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Exiting the system

Go to the File menu and select the Exit menu option or click on the “X” in the right upper
corner. In the confirmation dialog box that appears, click on the Save all and exit button to save
your work before exiting or Exit to exit. Click Cancel if you do not want to exit. All unsaved
information will be lost if you exit the system.

(3] QuanTB - Tuberculosis Medicines Quantification Tool [=[E] = ]
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Figure 71
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EXPORTING QUANTIFICATIONS TO EXCEL AND PRINTING

Quantifications can be exported into an Excel file (values only) at any stage of the process and
saved for references, comparison, or further analysis in Excel, or via Excel in other programs.

Export to Excel

Go to the Import & Export menu and select Export to Excel or click on the Excel icon in the
left upper corner. In the dialog box that appears, the system directs you to the “Docs” folder of
the system but you can select another location on your computer. Fill out the File Name field
and click on the Save button to confirm or Cancel to undo it.

The dashboard and stock quantity graphs will not be exported with the Excel file. You can copy
and paste those to another document, save them to another location, or print them. By right
clicking on your mouse, you can see the different options, including the option to zoom in and
out.

The quantification data can be printed as an Excel file. This is the only print option.

When you export to Excel, you can choose your type of export: All data or Without medicine
details. Exporting without the medicine details is faster.

r ™
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Figure 72
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O Note: The format of the Excel file is controlled by the user’s Windows configuration. For
example, if you are using the Russian version of QuanTB and your computer’s Windows
configuration is English (United States), the QuanTB Excel file date and number formats will be
in English (United States).

An example of the All details exported Excel file is shown below. There are multiple tabs of
information, including a separate tab for each medicine. The Excel export file without the
medicine details does not contain the separate tabs for each medicine.
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DIVIDING AND MERGING A QUANTIFICATION

Dividing a quantification

QuanTB has an option to divide a quantification. This may be useful, for example, if you create a
multi-year quantification and you want to divide it by year for procurement planning purposes.
To divide a quantification, open the quantification file, click the Divide & Merge menu, and
then click Divide quantification.

.
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Eto(250) Ethionamide 250mg Film coated tablet(s) 750,000 -

Lfx(250) Levofloxacin 250mg Film coated tablet(s) 1,019,000

PAS(Na) P-aminosalicylate sodium salt 4000mg Powder/Sac. 419 656
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Figure 74

A screen will appear so that you can enter the parameters of the subdivided forecasting. After it
is saved, the subdivided quantification will function like a regular quantification. The new
quantification only has information in the parameters tab, so you must execute it to see the
results, after you have reviewed the parameters.
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Figure 75

Certain rules must be understood when dividing a quantification:

Your inventory date in the subdivided quantification cannot be earlier than the inventory
date of the original quantification.

The start and end dates of the subdivided quantification cannot be earlier than the
inventory date of the original quantification or after the end of the original quantification.
If you move the inventory date later than the inventory date of the original quantification,
expected cases from the original quantification will become enrolled cases. Also, stock
on order will become stock on hand and some stock may expire. If the inventory date is
in the future, the stock information becomes an estimate.

If there was no expiration date entered for the stock on order, it will not have an
expiration date when it becomes stock on hand. QuanTB will consider the expiration date
to be the end of the quantification period. The system will allow you to leave the
expiration date blank. For greater accuracy in your new subdivided quantification, enter
an estimated expiration date for the stock on hand before you save, execute the
quantification, or export it to Excel.

If the stock on order from the original quantification has an expected date after the
inventory date of the subdivided quantification, it will still be stock on order in the
subdivided quantification.

If the stock on order from the original quantification has an expected receiving date at or
earlier than the inventory date of the subdivided quantification, it becomes stock on hand
in the subdivided quantification.

If your original quantification was done by percentage (rather than by number), the
percentages in the subdivided quantification may be different.
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e When you divide a quantification, you will lose the pack size and price information from
the original quantification.

e If you add up the total quantities from your subdivided quantifications, they may not
match the total of the original quantification. This is because of how the inventory date
can interact with the days medicines are consumed (frequency), when the regimen does
not specify that the patient take a medicine every day. Another reason for a mismatch is
because of how the lead time can overlap different quantification periods defined in
consecutive subdivided quantifications.

After you have subdivided your quantification and reviewed the parameters, save it and execute
it as you would a normal quantification. You will be prompted to enter an expiration date for the
medicines if they don’t have one.

Merging a quantification

QuanTB has an option to merge multiple quantification files. This is helpful, for example, if you
have quantifications done at the regional level of a country and want to combine them at the
central level. To merge two or more quantification files, open the relevant quantification files,
then go to the Divide & Merge menu and click the Merge quantifications option. Ensure that
you have saved the quantification files before merging them, because any changes made since
the last time you saved the files will not be merged.

e — -
(] QuanTE - Tuberculosis Medicines Quantification Tool - F=E
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Minimum manths of stack: Maximum months of stock: NTP
6 21 (months) |18 I (months)
Adjust medicines quantity for attrition Select treatment regimens
Expected increase in cases enrollment from May 2016
Comment: P
(-] Execute quantification
Enrolled cases = Expected cases | Stock of medicines
Quantity of medicines on hand and on order at the inventory date Batches Details Add Edit Delete
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Cm(1000) Capreomycin 1000mg Powder for injection 140,545 - A
Km(1000/4) Kanamycin 1000magidml Seolution for injection 36,827 72,000
Cs(250) Cycloserine 250mg Capsule(s) 321,059 250,000
Eto(250) Ethionamide 250mg Film coated tablet(s) 750,000 -
Lfx(250) Levofloxacin 250mg Film coated tablet(s) 1,019,000
PAS(Na) P-aminosalicylate sodium salt 4000mg Powder/Sac. 419 658
Pto(250) Protionamide 250mg Film coated tablet(s) 576,059
S&N-5/21Gx1.5 and Safety Box Syringe & needle (auto-disabli 400,000
'WFI(3) Water for injection 5ml 200,000
(500) Pyrazinamide 500ma Film uncoated tahlet(s) 0724 b
1 Copyright® 2012 Management Sciences for Health, Inc. All rights reserved. Developed by MSH.
Figure 76

A screen will appear for you to select which quantifications you want to merge. Tick the boxes to
select the quantifications, then click OK to continue or Cancel to cancel. A new quantification
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will be created from the quantifications you selected. The new quantification is only merging the
parameters of the component quantifications, so you must execute it to see results, after you have
reviewed the parameters.

When you merge quantifications, the system checks the inventory date, quantification start date,
type of regimen, whether the quantification was done by numbers or percentages, then the
regimens themselves to ensure that these values are the same in all quantifications. The order in
which the files are checked is the order that the quantifications appear on the selection list for the
merge. This means that the second file is compared to the first and if the second one doesn’t
match, you will get an error. If the first and second match, the third is the next to be compared,
and so on. The order the quantifications appear on the list is determined by the order in which
you opened the quantification files in the program before you selected the Merge option.

Note: We recommend that all parameters of component files be the same when merging files.

Forecasting files

D Fictitia 1-1-2013 fast rev.qth
] Fictitia 1-1-2013 slow rev.gtb

|

Figure 77

Certain things must be understood when merging quantifications:

e The inventory date must be the same in all of the files to be merged.

e The merged file will have the longest lead time and the longest quantification period of
the component files.
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e The merged file will not have the maximum and minimum months of stock, the name of
the country/region/facility or the name of the person performing the quantification.

e You can only merge quantifications if they were done by the same method, i.e., by
number or by percentage. You cannot merge a quantification done by number with a
quantification done by percentage.

e You can only merge quantifications if they were done for the same regimen type, i.e.,
multidrug or single-drug. You cannot merge a quantification using multidrug regimens
with a quantification using single-drug regimens.

e You can merge quantifications done by percentage if the enrolled and expected cases are
both done by percentage, if the composition of the regimens is the same, and if each
quantification’s regimens have the same percentage.

o If the component quantifications done by percentage have multidrug regimens,
the enrolled and expected cases for each regimen must have the same percentage
in each quantification. (The percentage for enrolled and the percentage for
expected can be different from each other.)

o If the component quantifications done by percentage have single-drug regimens,
you can have different regimens as long as the percentages for the regimens that
exist in more than one quantification are the same. Each regimen of the enrolled
and expected cases can have different percentages as long as they are the same in
the other quantifications to be merged.

e When you merge quantifications, the merged file will not have pack prices or sizes.
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USING QUANTB AS AN EARLY WARNING SYSTEM

Regular monitoring

When used regularly (e.g., quarterly or monthly), QuanTB can serve as an effective early
warning system to monitor the availability of medicines. This is especially important for rapidly
expanding programs, or programs phasing-in/phasing-out TB medicines or regimens. A
previously developed quantification file can be opened a month or a quarter later, saved as a new
forecast, and edited for actual cases versus planned for the elapsed period, stock of medicines on
hand updated to reflect the consumption, stock on order turned into stock on hand with
expiration dates, etc. QuanTB will then alert you to possible issues that may lead to treatment
interruptions or waste of medicines. If the stock of a medicine is below the minimum level or
above the maximum level, it will appear in red in the Estimated months of stock column.

For example, a TB program may appear to be quite balanced in the beginning of year, with
sufficient stock of medicines to cover current and expected cases through the year until the next
regular procurement, with some medicines being over the maximum set level of 12 months
(below):

Parameters | Summary | Medicines Report | Cases Report| Medicines Detailed Report | Order and Schedule = Graphs

Fictitia NTP Expected increase in cases enrollment from May 2016

On the inventary date Accelerated arder period Regular order period Gluantity to order
Mar 31, 2018 Apr01, 2016..5ep 30, 2016 Qct01, 2016..Dec 31, 2017 Apr01, 2016, Dec 31,217
{183 days) (457 days) (640 days)
Medicine mgﬁlhrg.uf Quantity Stock on Estimated Estimated
Stock on Stock an Quantity hand after Stock on Quantity likely  consumption  consumption  Accelerated Regular
stock likely to M q Total
hand . arder dispensed accelerated arder to expire {enrolled {expected arder period  arder period
(excluding expire
arder period cases) cases)
an arder)
[A]
Capreomycin 1
1000mg Powder 140,545 18 = 22,164 - 118,381 = - 104 143,003 = 61,302 61,302
for injection
Kanamycin
1000'.“9'4"“ 36,827 6 72,000 31,656 - 77,171 = - 338 170,457 25535 103022 128 568
Solution for
injection |
EEEas 321,089 12 - 89,271 - 231788| 250,000 - 34119 746763 - 529116 520,116
250mg Capsule(s)
Ethionamide
250mg Film 750,000 16 - 173,985 - 576,015 - - 117,120 855,957 - 662,418 662,418
coated tablet(s)
E
Figure 78

The situation in that same TB program may look very different three months later when it
becomes clear that the number of actually enrolled cases during the previous quarter exceeds the
planned numbers, and so will the expected number (e.g., due to successful implementation of
new diagnostic technology). Some medicines (with estimated months of stock shown in red) are
now at the critical level of availability and will require accelerated procurement:
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Parameters H Summary || Medicines Report || Cases Report H Medicines Detailed Report H Order and Schedule ” Graphs
f

Fictitia NTP Faster enrollment than expected

On the inventary date Accelerated arder period Regular arder period Quantity to order
Mar 31, 2016 Apr01, 2016, 8ep 20,2016 Oct01, 2016 Dec 31, 2017 Apr01, 2016, Dec 31,2017
(183 days) (457 days) (640 days)
Medicine m:ﬁm o Quantity Stock on Estimated Estimated
Stock on Stock on Cluantity hand after Stock on Quantity likely  consumption  consumption  Accelerated Regular
stock likely to ) . Total
hand arder dispensed accelerated arder to expire (enrolled (expected arder period  arder period
{excluding expire
arder period cases) cases)
on ordery
[A]
Capreomycin
1000mg Powder 140,545 13 - 49,278 91,267 - 1,300 185,860 - 158,293 158,293
for injection
Kanamycin
")DDI-HQ.MI'M 36,827 4 72,000 37,897 70920 = 1,040 247120 100,500 178,880 279,280
Solution for
injection
EELEE 321,050 9 - 167,874, 153,185, 250,000 137,823 980,355/ 106,282 1,117,661 1223043
250mg Capsule(s)
Ethionamide
125mg Film 750,500 12 = 252,297 498,203 = 166,935 1,291,500 = 1,623,232 1,623,232
coated tablet(s)
v
Figure 79
| Parameters H Summary ” Medicines Report H Cases Report || WMedicines Detailed Report || Order and Schedule H Graphs
| Slockuuantlty\ Dashboard
Inventory date: Mar 31, 2016 Total enrolled cases: 473 Total expected cases: 2,915
Motinuse M Stock onhand  Stock on order M Stock out
Apr16  May18  Jun16  Jul16  Aug 18  Sep 18 Ot 16 MNov18 Dec18  Jan17  Feh 17 Mar17  Apri7  May 17 Jun17  Jul17  Aug17  Sep17  Oct17  Naw17  Dec17
Beginning of quantification 1
Min._menths of stock Max_maonths of Stock
Capreomyein
T  —
Kananyein T
e T —
Cycloserine I -1
e I —
Ethionamide eeeee—,s
in e |
e B ————————————
P-amincsshicylste sodium sait e 0 0 0 0 1
Cop e e
Protionamide T
Pyrazinamide /0000 0 0 0/ 0 0 0
o T —

Figure 80

In yet a different scenario, that same program three months later may be failing to enroll the
planned number of cases, e.g., due to slower than planned uptake of diagnostic technology, or
lack of funding for patient care. In this case, it will be alert to the impending expiration of some

medicines:
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Parameters | Summary | Medicines Report Cases Report Medicines Detailed Report | Order and Schedule | Graphs

Fictitia NTP Slower enrollment than expected

On the inventary date Accelerated order period Regular order period Guantity to arder
Mar 31, 2016 Apr01, 2016..5ep 30, 2016 Qct01, 2016...Dec 31, 2017 Apr01, 2016, Dec 31, 2017
(183 days) (457 days) (640 days)
Medicine mEiiLT:.nf Quantity Stock on Estimated Estimated
Stock on Stock on Quantity " hand after Stock on Quantity likely  consumption consumption  Accelerated Regular
stock " likely to . ) Total
hand arder dispensed accelerated arder 1o expire (enrolled (expected order period  order period
(excluding expire
arder period cases) cases)
on arder)

(4]

Capreomycin Bl

1000mg Powder 140,545 21 = 9,620 - 130,925 = 33,136 130 84,296 = 17,837 17,837

for injection

Kanamycin

1UUU!‘HQI’4I‘"\ 36,827 8 72,000 20,521 - 88,308 = - 312 129,965 20,075 68,698 88,771

Solution for

injection

EEm 321,059 7 - 48900 : 272,159 250,000 = 42333 334,021 - 115,575 115,575

250mg Capsule(s)

Ethionamide

125mg Film 750,500 19 = 143319 - 607,181 = - 108,908 617,673 = 452,068 452 062

coated tablet(s)
[l

r
Figure 81

When using QuanTB files for early warning system monitoring, you must update the following
parameters:

e Inventory date

e Quantification period, if the time period for the quantification period is below the sum of
inventory date plus the lead-time date. In this situation, you must extend your
quantification period but you do not need to include additional cases in the expected
cases tab.

e Expected cases

e Stock of medicines (stock on hand and stock on order). If stock is expired, you must
delete that stock from the system, or the system will display an error message. If you
have received a stock previously on order, make sure it is deleted from the system and
included as stock on hand.

For example, if you have to update every three months, you need to ensure that you collect the
current total number of enrolled cases per month in the previous three months and enter in the
enrolled case field. For expected cases, review the patient trend to make sure it is the same based
on current enrolled cases collected. If the trend is not the same, make adjustments as needed.

We strongly recommend that you update your forecast with current information every
three months and execute it again.

Viewing QuanTB files created by others

QuanTB quantification files can be e-mailed to others for review. Files can be accessed in the
locations where QuanTB was saved after installation. Go to the Docs folder (e.g.,
C:\Users\yourname\QuanTB\docs) to select the QuanTB quantification file you want to email to
your colleague.
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Upon receipt of your QuanTB quantification file, your colleague can save the file in a location
where it can be accessed. The QuanTB quantification file can be opened and your colleague can
view or make certain changes in the file received. However, he or she will not have access to the
medicines and regimens lists (dictionaries) for that quantification in the system unless they are
added to the colleague’s copy of QuanTB. To do this, open the other person’s quantification file,
go to the Medicines & Regimens menu, and then click Add from quantification.

(] QuanT8 - Tuberculosis Medicines Qua;iﬁcaﬂﬂn Tool - E=rE——)
File Medicines & Regimens Impon;Expon Divide & Merge Help
[9 | Edit medicines =z =
Edit treatment regimens P 9) USAI D S I)S /7/
Add from quantification L /) FROM THE AMERICAN PEOPLE "\ e r e

Fictitia_2016 % | JEF Test ¥

Parameters | Summary Medicines Report  Cases Report  Medicines Detailed Report  Order and Schedule  Graphs

Name of Country/Region/Facility:

Inventory date: Lead time End date of quantification: Quantification period:
Fictitia

Mar 21, 2016 - "6 < (months) Dec31.2017 20 months, 30 days Name ofthe person performing the quantification:

Minimum months of stock: IMaximum months of stock: NTP

| 8 Z] (months) 18 I (months)

Adjust medicines quantity for attrition Selecttreatment regimens
Expected increase in cases enrollment from May 2016
Comment:
-] Execute quantification

Enrolled cases = Expected cases | Stock of medicines

Quantity of medicines on hand and on order at the inventory date Batches Details Add Edit Delete
Wedicines Stock Stock EEIE E e Expiration date Quantity Batch number andior comments
on hand on order receiving date

Cm(1000) Capreomycin 1000mg Powder for injection 140,545 - Al
Km(1000/4) Kanamycin 1000mag/idml Selution for injection 36,827 72,000
Cs(250) Cycloserine 250mg Capsule(s) 321,059 250,000
Eto(250) Ethionamide 250mg Film coated tablet(s) 750,000 -
Lfx(250) Levofloxacin 250mg Film coated tablet(s) 1,019,000
PAS(Na) P-aminosalicylate sodium salt 4000mg Powder/Sac.. 419,656
Pto(250) Protionamide 250mg Film coated tablet(s) 576,059
S&N-5/21Gx1.5 and Safety Box Syringe & needle (auto-disabli... 400,000
'WFI(5) Water for injection 5ml 200,000

(500) Pyrazinamide 500ma_Film uncoated tanlet( 0724 b

l Copyright ® 2012 Management Sciences for Health, Inc. All rights reserved. Developed by MSH.
Figure 82

QuanTB will then automatically compare the medicines and regimens in the quantification file to
the medicines and regimens in your copy of QuanTB and will add any new ones to your
dictionary files (lists).

It is important to note the following about the adding process:

e When QuanTB compares the medicines in the quantification to the medicines in your
dictionary, it will not import a medicine with an identical name, strength, form, etc. It
will import the medicine if there are any differences, even if the difference is only slight.

e When QuanTB compares the regimens in the quantification to the regimens in your
dictionary, it will not add regimens with identical compositions to your regimens. If there
are any differences between a quantification’s regimen and your regimen—even only a
space or a period—it will add the regimen to your dictionary.

After QuanTB compares the medicines and regimens in the quantification file to those in your
dictionary and adds the ones that you are missing, it will display a screen summarizing the
medicines and regimens that were imported.
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IMainWindow.menuForecasting.ItemExportToDic! .g

@ Medicines added:

& Cs(250) Cycloserine 250mg Capsule(s)(Second-line oral bacteriostatic)

& Eto(125) Ethionamide 125mg Film coated tablet(s)(Second-ine oral bacteriostatic)

# PAS(Ma) P-aminosalicylate sodium salt 4000mg Powder/Sachet(Second-line oral bacteriostatic)
& Pto(250) Protionamide 250mg Film coated tablet(s)(Second-line oral bacteriostatic)

Regimens added:

@ MDR-TB Regimen 1 (weight 51-70kg) 8Cm{1000)Cs(250)Lx(250)Pto(250)Z(500M14Cs(250)Lx(250)Pto(250)2(500)
& MDR-TB Regimen 2 (weight 51-70kg) 8Km(1000/4)Eto(125)Lx(250)PAS(Na)Z (50001 4Eto(125)Lx(250)PAS(Na)Z(500)

(T

Figure 83
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ANNEX 1: QUANTIFYING FOR MULTIPLE YEARS

QuanTB can be used for multiple year forecasts to determine budget requirements for
procurement and planning purposes. Follow the steps below for a multiyear forecast. If you later
want to divide a multi-year forecast, e.g., to determine annual procurement quantities, use the
Divide Quantification option.

1.

2.

10.

11.

12.

13.

Customize the medicines and treatment regimens as required to match your situation.

Click File, then New to begin a new quantification.

Inventory date: Since no stock information is required for this forecast, you can enter a
date one month before your quantification period. Recall that your quantification period

should be a date greater than the inventory date and the lead-time in months.

Lead time in months: Since this exercise is not for procurement, but just to determine
the budget, you can simply enter the number 1 in this field.

End date of quantification: This should be set to create a two- to five- year forecast, or longer as
required.

Minimum months of stock: Enter the number 1.

Maximum months of stock: Enter the number 1.

Regimen type: Select Multidrug or Single drug, as appropriate.

Enrolled cases: Use the option of By number.

Expected cases: Use the option of By number.

Select the regimens or single medicines for the forecast, then click Save.

Enrolled cases: Leave this field blank since we are estimating needs for future cases.

You will receive a warning message informing you that at least one enrolled case should

be entered for each regimen or medicine. Select “yes” and continue.

Expected cases: There are two options to input cases in this field:

a. Option 1: Enter the total number of cases expected by month for each regimen or

medicine starting from the first month of your quantification period. Example, if
you have a total of 1260 cases to enroll in two regimens with a regimen split of

80% and 20% for a quantification period between Jan. 1 2014 to Dec. 31, 2016;
you have to enter 28 cases for regimen A and 7 cases for regimen B each month.
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After entering data in the last month (Dec. 31, 2016), go back and change your
forecast period from Dec. 2016 to Dec. 2018. DO NOT ENTER ADDITIONAL
DATA from Jan. 2017. Because QuanTB computes patient needs as they are
enrolled, patients enrolled in Dec. 2016 would only have received one month of
treatment, in Nov. 2016, 2 months of treatment and so on. For complete treatment
quantities, you have to extend the quantification period without adding additional
data to allow patients complete their treatment. When planning for procurement,
and considering enrolled cases and stock information is considered, you do not
need to do this because with regular planning and updating of QuanTB, medicines
will be purchased and consumed as patients are enrolled.

b. Option 2: Enter the total number of cases expected for each regimen or medicine
for the total duration of the forecast in the field for the first month of the
quantification period. Using the same example above, enter 1008 cases for
regimen A and 252 cases for regimen B in Jan. 1, 2014. For this option, make sure
that the quantification period is equal to or longer than the duration of treatment.
If not, follow instructions for option 1 above.

14. Stock of medicines: Leave this field blank. The forecast is for budget purposes only.
15. Execute quantification.

16. Save your result.
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The main challenge with quantifying ancillary medicines is making sure you have the right data.
Most countries do not collect and compile data on adverse events and some countries do not have
standardized guidelines for managing adverse events. In such situations, you need to use proxy
data that would provide the most accurate estimate for your forecast. As data becomes available,
later forecasts should be more evidence-based.

Some key data requirements are:

List of recommended ancillary medicines for TB adverse events treatment.
Ancillary medicine specifications (medicine name, strength, unit/pack price, etc.)
Recommended quantity, duration, and frequency for each condition treated.

Historic data on number or percentage of TB cases that will be treated with ancillary
medicines.

Data on total number or percentage of patients enrolled to receive ancillary medicine for
the most recent 6 months (if the program is long-running).

Previous quantification assumptions used for ancillary medicine quantification (if
previously done).

Country targets, expansion plans, planned interventions, etc. for TB ancillary treatment in
the country.

Total quantity of stock on hand for each ancillary medicine, with:
o0 Expiration dates for each ancillary medicine by batch

0 Total quantity of stock on order (order placed but not yet received) for each
ancillary medicine and date order is expected for delivery

o Total lead time for procurement (consider total lead time from planning, to
ordering, to shipment, to actual receipt in central warehouse for distribution

o Total minimum stock level (consider all health care levels)

To forecast for ancillary medicines, you should use the Single Drug option for this forecast. You
cannot use the single drug option and the regimen option at the same time. If you quantify other
medicines by regimen, you must perform a separate quantification for single drugs.

To forecast using QuanTB, follow the steps below:
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10.

11.

12.

13.

14.

15.

Select your medicines and treatment regimens. For each medicine, include the total
duration of time for treatment per case for the entire period of treatment. (Some adverse
events may be treated two or three times during the course of a TB treatment; ensure you
agree on an average to use for the forecast.)

Click File, then New to begin a new quantification.

Inventory date: Enter the date you took your stock status information. If no previous
stock information is available, then ensure the quantification period is equal to or greater
than the sum of the inventory date and the lead time in months.

Lead time in months: Enter the total time required from planning until medicine is
received in the store.

Quantification period: Enter the period for which you are quantifying.
Minimum months of stock: Enter the minimum stock level agreed on for the medicines.

Maximum months of stock: Enter the maximum stock level agreed on for the
medicines.

Regimen type: Select the Single drug option and select to forecast either by number or
by percent depending on the data available.

Select regimens: Select the regimens you want to include in the forecast.
Click Save.

Enrolled cases: Enter the percentage of enrolled cases for each medicine. Then enter the
total number of enrolled cases per month.

Expected Cases: Enter the percentage of expected cases for each medicine. Then enter
the total number of expected cases per month.

Stock of medicines: Leave these fields blank if no data is available (that is, if medicines
have not been purchased by the program in the past).

Click Execute quantification.

Save your results.
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QuanTB does not have a specific feature to forecast patient Kits, i.e., the complete medicine
requirement for the duration of treatment in one box for one patient. QuanTB considers patient
needs based on their enroliment date and calculates their needs (number of tablets per day,
number of days per week, and duration in months) for the complete month (28, 30, or 31 days
depending on the calendar month) until the quantification period ends. This means that if you
assume that each case will receive 3 tablets daily for 7 days, QuanTB calculates that until
treatment is complete and does not take into account wastages and weight adjustments during the
forecasted period. Wastages can be adjusted in the order tab.

To forecast for patient kits, follow the steps below:

1. Create the kits as medicines in the Medicines list. If the kit contains two or more
different products, you must enter each under separate names in the INN field. To
differentiate regular medicines from patient kit medicines, set your medicine INN name
as “patient kit” including any other identifiers if you have multiple Kkits in use. For
example, “patient kit new adult cases - intensive phase”. Use an abbreviated identifier in
the abbreviated name field example, “PK-Int (RHZE)”. Enter medicines strength and
dosage form and select type of medicines. Follow the same procedure for continuation
phase medicines and save.

2. Create your regimen for the patent kit, including any other identifiers if you have

multiple Kits in use, for example, “patient kit new cases”. Then click on or enter the
composition of the regimen.

3. Click File, then New to begin a new quantification.

4. Inventory date: Enter the date you took your stock status information.

5. Lead time in months: Enter the total time required from planning until medicine is
received in the store.

6. Quantification period: Enter the period for which you are quantifying. Ensure the
forecasting period is equal to or greater than the sum of inventory date and lead time in
months.

7. Minimum months of stock: Enter the minimum stock level agreed on for the medicines.

8. Maximum months of stock: Enter the maximum stock level agreed on for the
medicines.

9. Regimen type: Select the Multidrug option for this forecast.

10. Enrolled cases: Use the option of By number.
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

Expected cases: Use the option of By number.
Select the regimens for the forecast, then click Save.

Enrolled cases: Enter the number of cases enrolled in treatment by month for each
regimen.

Expected cases: Enter the number of cases expected for treatment by month for each
regimen.

Stock of medicines: Convert each patient kit contents into units. For example, a kit may
contain 168 tablets of RHZE and 336 tablets of RH. Multiply these totals by the total
number of patient Kits to get the overall total units for each medicine. Enter each
medicine’s expiration date by batch. Follow the same steps for stock on order.

Execute quantification.

Click on the Order tab. On the Quantity tab, in the Pack Size column, enter 168 for
RHZE and 336 for RH for the patient kits medicines (based on the example above; adjust
your figures as necessary). Notice that quantities may vary slightly because QuanTB does
not adjust for wastages and calculates needs until patient stops treatment. Use the higher
number as the total pack size to procure.

Make additional upward or downward adjustments in the Adjustment (% of quantity
needed) column.

Enter the Pack price for procurement.

Click on the Final cost tab to enter additional costs, such as shipping, insurance, etc.
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ANNEX 4: REPORTING AN ERROR

If you receive an error message with an “Exception caught:” error, please let us know so that we
can continuously improve QuanTB.

Error 5

e Exception caught:
java.lang.ArraylndexOutOfBoundsException: 0

Figure 84

Report problems to guantb@msh.org with the following information:

=

A step-by-step list of what you were doing in QuanTB when you got the error.

A screen capture of the error message itself.

3. The log file that QuanTB creates automatically about the error. If you installed the
software in the default location, the error file will be in
C:\users\yourname\QuanTB\data\log. The file name will contain the date of the error,
e.g., 2014-02-20err.qtb.

N
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